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Guide Math

Préface



À qui s’adresse ce guide ?

LibreOffice Math est un éditeur de formules (équations) et  une partie intégrante de LibreOffice.
Toute  personne  souhaitant  apprendre  à  insérer  des  formules  et  des  équations  grâce  à  Math
trouvera ses réponses dans ce guide.

Si vous n’avez jamais utilisé LibreOffice Math auparavant, ou si vous recherchez une introduction à
tous les modules de LibreOffice, nous vous invitons à lire le Guide du débutant de LibreOffice.

Où trouver de l’aide supplémentaire ?

Ce guide, comme les autres guides d’utilisateur de LibreOffice, le système d’aide intégré et les
systèmes  d’aide  à  l’utilisateur,  suppose  que  vous  êtes  à  l’aise  avec  votre  ordinateur  et  les
fonctionnalités de base comme le démarrage d’un programme ou l’ouverture et la sauvegarde de
fichiers.

Système d’aide
LibreOffice est  fourni  avec une  aide étendue.  Il  s’agit  de votre première ressource d’aide pour
l’utilisation de LibreOffice. Les utilisateurs de Windows et de Linux peuvent télécharger et installer
une aide intégrée, utilisable sans connexion Internet ; celle-ci est installée avec le programme sous
Mac OS X.

Pour afficher le système d’aide, appuyez sur la touche F1 ou cliquez sur Aide de LibreOffice dans
le menu Aide. De plus, vous pouvez activer les Infoballons dans Outils > Options > LibreOffice >
Général dans la barre de menu.

Si l’option Infoballons est cochée, il suffit de survoler une icône pour faire apparaître une petite bulle
d’information  donnant  une  brève  explication  de  la  fonctionnalité  de  cette  icône.  Pour  des
explications plus détaillées, sélectionnez Aide > Qu’est-ce que c’est ? dans la barre de menu, et
survolez l’icône avec le pointeur.

Support en ligne gratuit
La communauté de LibreOffice, en plus de développer le logiciel, offre un support gratuit basé sur le
volontariat. Voir le Tableau 1 et cette page web : https://fr.libreoffice.org/get-help/ 

Tableau 1 : Support gratuit pour les utilisateurs de LibreOffice
Poser une 
question

Questions et réponses de la communauté des utilisateurs
https://ask.libreoffice.org/fr/questions/

Documentation
Guides d’utilisateur, tutoriels et autre documentation : 
https://wiki.documentfoundation.org/FR/La_documentation_de_l'utilisateur
https://wiki.documentfoundation.org/Documentation/Publications/fr 

Listes de diffusion
Un réseau d’utilisateurs expérimentés fournit une aide gratuite à toute la 
communauté : https://fr.libreoffice.org/get-help/mailing-lists/

FAQ
Réponses aux questions fréquentes : 
https://wiki.documentfoundation.org/Faq/fr

Support 
international

Le site web de LibreOffice en français : https://fr.libreoffice.org/ 
Le site web de LibreOffice en d’autres langues :
https://www.libreoffice.org/community/nlc/
Listes de diffusion internationales :
https://wiki.documentfoundation.org/Local_Mailing_Lists
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Options 
d’accessibilité

Informations sur les options d’accessibilité disponibles 
https://fr.libreoffice.org/get-help/accessibility/

Vous pouvez aussi obtenir une  aide en ligne exhaustive de la communauté grâce aux listes de
diffusion  et  le  site  web  Ask  LibreOffice :  https://ask.libreoffice.org/fr/questions/.  Vous  trouverez
également  d’autres  sites  gérés  par  des  utilisateurs,  qui  partagent  des  astuces  et  des  tutoriels
gratuits. Le forum suivant fournit de l’aide aux utilisateurs de LibreOffice, entre autres :
https://forum.openoffice.org/fr/forum/. 

Support payant et formation
Vous pouvez également obtenir des contrats de service support payant auprès d’un revendeur ou
d’une société de consultants spécialisés dans LibreOffice. Pour obtenir des informations au sujet de
support professionnel, consultez le site de The Document Foundation :  https://fr.libreoffice.org/get-
help/professional-support/

Ce que vous voyez peut être différent

LibreOffice,  disponible  en plusieurs versions  sur  les  systèmes d’exploitation  Windows,  Linux  et
macOS peut  être  personnalisé  par  les  utilisateurs  (polices,  couleurs,  thèmes,  gestionnaires  de
fenêtres).

Illustrations
Les  illustrations  de  ce  guide  proviennent  du  système  d’exploitation  Windows 10.  Certaines  ne
ressembleront donc pas nécessairement à ce que vous verrez sur votre écran.

De  même,  certaines  boîtes  de  dialogue  peuvent  être  différentes  en  raison  des  réglages
sélectionnés dans LibreOffice. Vous pouvez soit utiliser les boîtes de dialogue de votre système
d’exploitation,  soit  les  boîtes  de  dialogue  fournies  par  LibreOffice.  Pour  utiliser  les  boîtes  de
dialogue LibreOffice, si les réglages ont été modifiés :

1. Accédez aux options générales de LibreOffice :

– Sur  les  systèmes  Linux  et  Windows,  sélectionnez  le  menu  Outils  >  Options  >
LibreOffice > Général.

– Sur les systèmes Mac, sélectionnez le menu LibreOffice > Préférences > Général.
2. Sélectionnez  Utiliser  les  boîtes  de  dialogue  LibreOffice dans  Boîtes  de  dialogues

ouvrir/enregistrer pour  afficher  et  utiliser  les  boîtes  de  dialogue  LibreOffice  lors  de
l’ouverture ou de l’enregistrement de fichiers.

3. Sur les systèmes Linux, sélectionnez Utiliser les boîtes de dialogue LibreOffice dans Boîtes
de dialogue Imprimer pour afficher et utiliser les boîtes de dialogue LibreOffice lors de
l’impression de fichiers.

4. Cliquez sur OK pour enregistrer vos réglages et fermer la boîte de dialogue.

Remarque

Si  vous  utilisez  un  système Linux  en  tant  que  machine  virtuelle  sur  un  ordinateur
tournant sous Windows ou Mac, l’option Boîtes de dialogue Imprimer n’est alors pas
disponible.
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Icônes
Les icônes utilisées dans ce guide pour illustrer les nombreux outils disponibles dans LibreOffice
peuvent différer de celles affichées sur votre écran. Les icônes de ce guide sont les icônes par
défaut. Si vous souhaitez modifier vos icônes LibreOffice :

1. Accédez aux options d’affichage de LibreOffice :

– Sur les systèmes Linux et Windows, sélectionnez le menu Outils > Options LibreOffice
> Affichage.

– Sur les systèmes Mac, sélectionnez le menu LibreOffice > Préférences > Affichage.
2. Dans Style d’icônes, sélectionnez le style souhaité dans la liste déroulante Style d’icônes.

3. Cliquez sur OK pour enregistrer vos réglages et fermer la boîte de dialogue.

Utiliser LibreOffice sur macOS

Sur macOS, certaines touches et certains éléments de menu sont différents de ceux utilisés sous
Windows ou Linux. Le tableau ci-dessous montre quelques-unes des substitutions courantes pour
les instructions de ce guide. Pour une liste plus détaillée, veuillez consulter l’Aide de l’application.

Windows ou Linux Équivalent Mac Effet

Sélection du menu 
Outils > Options

LibreOffice > Préférences Accès aux options de configuration

Clic droit
Control + clic ou clic droit selon 
la configuration de l’ordinateur

Ouvre un menu contextuel

Ctrl (Control)  ⌘ (Command) Utilisé avec d’autres touches

F11 ⌘+T Ouvre la fenêtre Styles et formatage
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Introduction

Math est un module d’édition  de formules fourni avec LibreOffice qui permet de créer ou d’éditer
des formules (équations) sous forme symbolique, à l’intérieur des documents LibreOffice ou en tant
qu’objet indépendant. Des exemples de formules sont donnés ci-dessous :

df (x )
dx

=ln (x )+tan−1 (x2 ) ou NH3+H2O⇌ NH4
+
+OH−

La zone d’édition de Math utilise un langage de balisage pour représenter les formules. Ce langage
de balisage est  conçu pour  être facilement  lisible comme de l’anglais  (ou du français  pour les

caractères grecs et spéciaux), où que ce soit. Par exemple,  a over b va donner la fraction  
a
b

lorsque ce code est utilisé dans une formule (over signifiant au-dessus de en anglais).

Sachez cependant que LibreOffice Math ne peut pas évaluer des formules mathématiques ou faire
des calculs à proprement parler. Pour réaliser ces actions, veuillez consulter le Guide Calc.

Pour commencer

Vous pouvez créer une équation (formule) en utilisant l’éditeur de formule en tant que document
séparé ou vous pouvez l’insérer directement dans un document Writer, Calc, Impress ou Draw.

Création d’une formule en tant que document séparé
Pour créer une formule en tant que document séparé, ouvrez le module Math de LibreOffice (Figure
1  :  Vue  d’ensemble  de  l’interface  de  Math  lors  de  l’édition  d’une  formule)  avec  une  de  ces
méthodes :

• Dans la barre de menu, sélectionnez Fichier > Nouveau > Formule.

• Dans la barre d’outils standard, cliquez sur le triangle à droite de l’icône  Nouveau  et

sélectionnez Formule.

• À partir du centre de démarrage, cliquez sur Formule.

• Depuis LibreOffice Math, utilisez le raccourci clavier Ctrl + N.

• Démarrer Math depuis l’invite de commande en tapant libreoffice –math
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Figure 1 : Vue d’ensemble de l’interface de Math lors de l’édition d’une formule

Au fur et à mesure que vous tapez du langage de balisage dans l’éditeur de formule, l’équation
apparaît dans la fenêtre de visualisation. Le panneau Éléments situé à gauche de la fenêtre de
visualisation apparaît également si l’option a été sélectionnée dans le menu Affichage. La Figure 2 
: Activer le panneau Éléments montre comment activer le panneau Éléments dans Math. Pour plus
d’informations sur la création des formules, veuillez vous reporter à « Écriture des formules » à la
page 13.

Figure 2  : Activer le panneau Éléments
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Insertion d’une formule dans un document LibreOffice
Pour insérer une formule dans un document LibreOffice, ouvrez le document dans Writer, Calc,
Draw ou Impress.  Le module LibreOffice utilisé modifie  la façon de positionner le  curseur pour
insérer la formule :

• Dans Writer, cliquez dans le paragraphe où vous souhaitez insérer la formule.

• Dans Calc, cliquez sur la cellule dans laquelle vous souhaitez insérer la formule.

• Dans Draw et Impress, la formule est insérée au centre du dessin ou de la diapo.

Puis sélectionnez dans la barre de menu  Insertion > Objet > Formule pour ouvrir  l’éditeur de
formule. Alternativement,  vous pouvez sélectionner dans la barre de menu  Insertion > Objet >
Objet OLE pour ouvrir la boîte de dialogue, puis sélectionnez Créer un nouvel objet, choisissez le
type d’objet « Formule LibreOffice  7.0 » puis cliquez sur  OK pour ouvrir l’éditeur de formule. Le
panneau Éléments à gauche de la fenêtre ou en tant que fenêtre flottante peut apparaître, selon les
sélections du menu Affichage. Pour plus d’informations sur la création de formules, veuillez vous
reporter à la section « Écriture des formules » à la page 13.

La Figure 3 : Formule vide dans un document Writer donne un exemple de document Writer avec la
boîte de formule ouverte et prête à la création d’une formule.

Figure 3  : Formule vide dans un document Writer
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Lorsque le code de balisage de la formule est entré, vous pouvez fermer l’éditeur en appuyant sur
la touche Échap ou en cliquant hors de la formule dans le document principal. Un double-clic sur la
formule ouvrira à nouveau l’éditeur, vous pourrez ainsi modifier la formule.

Les formules  sont  insérées en tant  qu’objets  OLE.  Comme avec tout  objet  OLE,  vous pouvez
modifier la façon dont l’objet est positionné dans votre document. Pour plus d’informations sur les
objets OLE, reportez-vous au Chapitre 2  Les formules dans Writer, Chapitre 3  Les formules dans
Calc, Draw et Impress ainsi qu’aux guides pour Writer, Calc, Draw et Impress.

Si vous devez régulièrement insérer des formules, il est préférable d’ajouter le bouton Formule à la
barre  d’outils  Standard  ou  de  créer  un  raccourci  clavier.  Veuillez  consulter  le Chapitre 4
 Personnalisation pour plus d’informations.

Écriture des formules

Vous pouvez écrire une formule de différentes façons :

• Dans le panneau Éléments, sélectionnez une catégorie dans la liste déroulante, puis un
symbole du panneau.

• Faites un clic droit dans l’éditeur de formule et sélectionnez le symbole à partir du menu
contextuel.

• Écrivez directement dans l’éditeur de formule en vous servant du langage de balisage.

Remarque

Utilisez le panneau Éléments ou le menu contextuel pour insérer une formule vous
permet d’apprendre simplement le langage de balisage utilisé par LibreOffice Math.

Astuce

Lors de l’utilisation du panneau Éléments, il est recommandé d’activer les  infoballons
dans les options de LibreOffice. L’activation vous aidera à identifier les catégories et
symboles que vous souhaitez utiliser dans votre formule. Sélectionnez depuis le menu
principal Outils > Options > LibreOffice > Général et sélectionnez Infoballons dans
la section Aide.

Panneau Éléments
Le  panneau Éléments  est  un  outil  visuel  qui  vous aidera  à  écrire  et  à  éditer  votre  formule.  Il
organise les symboles mathématiques et opérateurs dont vous pourrez avoir besoin classés en
Catégories dans une liste déroulante. Voir le haut de la Figure 4 : Panneau Éléments. Les étapes ci-
dessous expliquent comment activer le panneau Éléments et à quoi correspondent ses catégories
et symboles.

1. Dans le menu Affichage de l’éditeur de formule, cochez Éléments pour activer le panneau
Éléments.

2. Sélectionnez la  catégorie  souhaitée à  l’aide  de la  liste  déroulante  en haut  du panneau
Éléments.

3. Sélectionnez le symbole à utiliser dans le panneau. Les symboles disponibles sont modifiés
en fonction de la catégorie sélectionnée.

4. Après avoir choisi l’un des symboles du panneau Éléments, l’éditeur de formule sera mis à
jour avec la balise correspondante au symbole sélectionné.
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Figure 4  : Panneau Éléments

Remarque

Le panneau Éléments  est  soit  une fenêtre flottante comme le  montre  la  Figure  4 :
Panneau  Éléments,  soit  positionné  à  gauche  de  l’éditeur  de  formule  (position  par
défaut) comme sur les Figure 1 : Vue d’ensemble de l’interface de Math lors de l’édition
d’une formule et Figure 3 : Formule vide dans un document Writer.

Astuce

Vous  trouverez  aussi  une  catégorie  « Exemples »  dans  le  panneau  Éléments,
contenant des formules à utiliser comme base pour écrire votre formule ou équation.

Menu contextuel
Vous trouverez aussi un menu contextuel dans l’éditeur de formule pour accéder aux catégories et
aux symboles pendant l’écriture de votre formule. Faites un clic droit dans l’éditeur de formule pour
ouvrir  le  menu  contextuel.  Sélectionnez  une  catégorie,  puis  l’archétype  de  balisage  que  vous
souhaitez dans le menu contextuel, comme le montre la Figure 5 : Menu contextuel dans l'éditeur
de formule.

Remarque

Le panneau Éléments et le menu contextuel ne contiennent que les balises les plus
fréquemment utilisées dans les formules. Pour insérer d’autres symboles et balises qui
ne sont pas listés dans le panneau des éléments ou dans le menu contextuel, vous
devrez les écrire via le langage de balisage. Pour une liste complète des balises et
symboles  disponibles  dans  Math,  veuillez  consulter l’Annexe  A   Références  des
Commandes.
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Figure 5  : Menu contextuel dans l'éditeur de formule

Langage de balisage
Le langage de balisage est à utiliser directement dans l’éditeur de formule. Par exemple, écrire 5
times 4 (5 fois 4 en anglais) dans l’éditeur de formule crée la formule simple 5×4. Si vous êtes
adepte, le langage de balisage est la manière la plus rapide d’écrire une formule. Le Tableau  2
montre quelques exemples de langage de balisage à utiliser pour entrer une balise. Vous trouverez
une  liste  des  balises  à  utiliser  dans  l’éditeur  de  formule  dans  l’Annexe  A :  Référence  des
Commandes.

Tableau 2 : Exemples de balises utilisant le langage de balisage
Formule Balise Formule Balise

a=b a = b √a sqrt {a}

a2 a^2 an a_n

∫ f (x )dx int f(x) dx ∑an sum a_n

a≤b a <= b  ∞ infinity

a×b a times b x⋅ y x cdot y
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Caractères grecs

Utilisation du langage de balisage
Les caractères grecs sont souvent utilisés dans les formules. Cependant, ils ne peuvent pas être
insérés dans une formule depuis le panneau des éléments ou le menu contextuel. Utilisez le nom
français des caractères grecs dans le langage de balisage lorsque vous voulez les ajouter dans une
formule. Pour découvrir la liste des caractères grecs que vous pouvez ajouter grâce au langage de
balisage, veuillez consulter l’Annexe A: Référence - Commandes.

• Pour  un  caractère  grec  en  minuscule,  entrez  le  symbole  %  suivi  du  nom  français  du
caractère que vous souhaitez utiliser, en lettres minuscules. Par exemple, écrire %lambda
affiche le caractère grec λ .

• Pour un caractère grec en MAJUSCULE, entrez le symbole % suivi du nom français du
caractère  que  vous  souhaitez  utiliser,  en  lettres  MAJUSCULES.  Par  exemple,  écrire
%LAMBDA affiche le caractère grec Λ.

• Pour un caractère grec en  italique,  entrez le symbole % suivi  de la lettre i  puis le nom
français  du  caractère  que  vous  souhaitez  utiliser,  en  lettres  minuscules  ou  en  lettres
MAJUSCULES. Par exemple, écrire %iTHÊTA affiche le caractère grec Θ en italique.

Boîte de dialogue Symboles
Vous pouvez également ajouter un caractère grec à partir de la boîte de dialogue Symboles.

1. Assurez-vous que votre curseur  se  trouve bien au niveau de la  fenêtre  de l’éditeur  de
formule.

2. Cliquez sur  Outils > Symboles, ou sur l’icône Symboles   dans la barre d’outils, pour
ouvrir la boîte de dialogue Symboles (Figure 6 : Boîte de dialogue Symboles)

3. Choisissez Grec dans la liste déroulante Jeu de symboles. Pour les caractères en italique,
choisissez iGrec dans la liste déroulante.

4. Sélectionnez le caractère que vous souhaitez insérer dans la liste, puis cliquez sur Insérer.
Lorsqu’un caractère est sélectionné, son nom est affiché sous la liste des symboles.

5. Cliquez sur  Fermer lorsque vous avez terminé d’ajouter des caractères grecs dans votre
formule.

Figure 6  : Boîte de dialogue Symboles
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Exemples de formules

Exemple 1
La formule simple 5×4 peut être écrite des manières suivantes dans LibreOffice Math :

1. Cliquez  dans  l’éditeur  de  formule,  puis  sélectionnez  la  catégorie  Opérateurs
unaires/binaires, puis le symbole de la  Multiplication en utilisant une des méthodes ci-
dessous :

– Dans  le  panneau Éléments,  sélectionnez  Opérateurs  unaires/binaires dans  la  liste
déroulante, puis cliquez sur l’icône Multiplication .

– Faites un clic droit sur l’éditeur de formule et sélectionnez Opérateurs unaires/binaires
> a times b dans le menu contextuel.

– Les  deux  premières  méthodes  insèrent  le  code  <?> times <?> dans  l’éditeur  de

formule, et le symbole  dans le document.
– Grâce au langage de balisage, entrez 5 times 4 dans l’éditeur de formule pour insérer

la formule directement dans le document. Avec cette méthode, vous pouvez ignorer les
étapes suivantes.

2. Sélectionnez l’emplacement  <?> qui se trouve avant le mot  « times » dans l’éditeur de
formule  et  remplacez-le  par  le  chiffre  5.  La  formule  dans  le  document  s’actualise
automatiquement.

3. Sélectionnez l’emplacement  <?> qui se trouve après le mot  « times » dans l’éditeur de
formule  et  remplacez-le  par  le  chiffre  4.  La  formule  dans  le  document  s’actualise
automatiquement.

Astuce

Pour  avancer  d’un  emplacement  <?> à  un  autre,  appuyez  sur  la  touche  F4.  Pour
reculer d’un emplacement jusqu’au précédent, appuyez sur Maj+F4.

Remarque

Si vous le souhaitez, vous pouvez empêcher l’actualisation automatique des formules.
Ouvrez  le  menu  Affichage et  désélectionnez  Rafraîchir  automatiquement
l’affichage. Pour mettre à jour manuellement une formule, appuyez sur la touche F9 ou
sélectionnez Affichage > Actualiser dans le menu principal.

Exemple 2
Votre objectif est d’insérer la formule π≃3,14159 où la valeur de pi est arrondie à 5 décimales.
Vous connaissez le nom du caractère grec (pi), mais vous ne connaissez pas le balisage associé au
symbole Est similaire ou égal ≃.

1. Assurez-vous que le curseur clignote dans l’éditeur de formule.

2. Écrivez %pi dans l’éditeur de formule pour afficher le caractère grec pi (π).

3. Sélectionnez la catégorie Relations, puis le symbole Est similaire ou égal en suivant l’une
des méthodes ci-dessous :

– Sélectionnez Relations dans la liste déroulante du panneau Éléments, puis cliquez sur
l’icône Est similaire ou égal .

– Faites un clic droit dans l’éditeur de formule et sélectionnez Relations > a simeq b dans
le menu contextuel.

4. Supprimez le premier emplacement <?> devant le mot simeq dans l’éditeur de formule.
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5. Sélectionnez le second emplacement <?> après le mot simeq dans l’éditeur de formule, et
remplacez-le par la suite de caractères 3,14159. La formule π≃3,14159 s’affiche dans
votre document.

Modification d’une formule

Éditer une formule et passer en mode édition de formule dépend de la création de la formule dans
Math ou dans un autre module LibreOffice.

1. Dans Math, double-cliquez sur un élément de la formule qui apparaît dans la fenêtre Aperçu
pour le sélectionner dans l’éditeur de formule, ou sélectionnez directement un élément de la
formule dans l’éditeur de formule.

2. Dans Writer, Calc, Impress ou Draw, double-cliquez sur la formule, ou faites un clic droit sur
la formule et sélectionnez Éditer dans le menu contextuel pour ouvrir l’éditeur de formule et
activer  le  mode édition.  Le curseur  se  trouve au début  de la  formule dans l’éditeur  de
formule.

Remarque

Si  vous ne pouvez  pas sélectionner  un  élément  de la  formule  avec votre  curseur,

cliquez sur le bouton Curseur de formule  dans la barre d’outils Outils pour activer
le curseur de formule.

1. Pour sélectionner l’élément de la formule que vous souhaitez modifier :

– Cliquez sur l’élément de formule dans la zone d’aperçu, en plaçant le curseur au début
de l’élément de formule dans l’éditeur de formule, puis sélectionnez directement le code
dans l’éditeur de formule.

– Double-cliquez sur l’élément de formule dans la zone d’aperçu pour sélectionner le code
dans l’éditeur de formule.

– Positionnez le curseur dans l’éditeur de formule et sélectionnez directement l’élément de
formule que vous souhaitez modifier.

– Double-cliquez directement sur l’élément de formule dans l’éditeur de formule.
2. Apportez les modifications souhaitées à l’élément de formule sélectionné.

3. Depuis le menu  Affichage,  sélectionnez  Actualiser,  ou appuyez sur  F9,  ou cliquez sur

l’icône Actualiser  dans la barre d’outils pour actualiser la formule dans la zone d’aperçu
ou le document.

4. Dans Math, enregistrez les modifications apportées à la formule lorsque vous avez terminé.

5. Dans Writer, Calc, Impress ou Draw, cliquez sur une zone en dehors de la formule dans le
document pour quitter le mode édition, puis enregistrez le document pour sauvegarder les
modifications apportées.

Anatomie d’une formule

Ce segment vous fournit des conseils sur l’organisation d’une formule complexe dans Math ou dans
votre document LibreOffice.

Utiliser des accolades
LibreOffice  Math  ne connaît  pas  la  priorité  des  opérateurs  au sein  d’une  formule.  Utilisez  des
accolades ({ }) pour indiquer dans quel ordre Math doit traiter les opérations. Les exemples suivants
indiquent comment utiliser des accolades dans une formule.
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Exemple 1

2 over x + 1 donne le résultat 
2
x
+1

Math comprend que le  2 et  le  x correspondent  au numérateur  et  au dénominateur  de la
fraction créée par la balise « over », et représente correctement la fraction. Si vous voulez
que x+1 soit le dénominateur, au lieu de x, il faut mettre x + 1 entre accolades.

Ajouter des accolades pour former la formule 2 over {x + 1} donne le résultat 
2
x+1

 où

x+1 est le dénominateur.

Exemple 2

– 1 over 2 affiche le résultat 
−1
2

Math reconnaît  le  signe moins  comme préfixe  de 1 et  l’inclut  donc au numérateur  de la
fraction. Pour appliquer la négativité à l’ensemble de la fraction, entrez le signe moins, une
accolade d’ouverture, une fraction, puis une accolade de fermeture.

En  ajoutant  des  accolades  à  la  formule  – {1 over 2},  on  obtient  le  résultat  –
1
2

 où

l’ensemble de la fraction est négatif.

Exemple 3
Les  accolades,  lorsqu’elles  sont  utilisées  dans  le  langage  de  balisage,  définissent  la
disposition de la formule sans être affichées ou imprimées. Pour insérer des accolades dans
une formule, utilisez les balises lbrace et rbrace dans le code.

x over {–x + 1} donne le résultat 
x

–x+1

Remplacez  les  accolades  avec  les  balises  lbrace et  rbrace du  langage  de  balisage.

Écrivez x over lbrace –x + 1 rbrace et le résultat sera 
x

{–x+1}

Parenthèses et matrices
Pour utiliser une matrice dans une formule, utilisez la balise matrix. Voici un exemple simple de
matrice 2 x 2.

matrix { a # b ## c # d } a b
c d

Dans les matrices, les lignes sont séparées par deux dièses (##), les colonnes par un dièse (#).

Les parenthèses simples ne s’adaptent pas à la taille de la matrice lorsque cette dernière s’agrandit.
Dans l’exemple suivant, les parenthèses de la formule ne sont pas mises à l’échelle du résultat de
la matrice.

( matrix { a # b ## c # d } ) (
a b
c d

)

Pour  remédier  au problème des parenthèses dans une matrice,  LibreOffice  Math  propose des
parenthèses pouvant s’adapter à la taille de la matrice. Utilisez les balises left( et right) pour
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créer des parenthèses ajustables autour d’une matrice. L’exemple suivant montre comment créer
une matrice à parenthèses ajustables.

left( matrix { a # b ## c # d } right) (a b
c d )

Les parenthèses ajustables peuvent également être utilisées avec n’importe quel élément de la
formule, comme une fraction, une racine carrée, etc.

Pour créer une matrice avec des valeurs vides, utilisez l’accent grave (`) pour que Math crée un
espace au même endroit, comme dans l’exemple suivant :

left( matrix { 1 # 2 # 3 ## 4 # ` # 6 } right) (1 2 3
4 6)

Astuce

Utilisez les balises left[ et right] pour obtenir des crochets ajustables. Une liste de
tous  les  types  de  parenthèses  est  disponible  dans  l’Annexe  A  Références  -
Commandes.

Pour  rendre  toutes  les  parenthèses  ajustables,  sélectionnez  le  menu  Format  >
Espacement pour  ouvrir  la  boîte  de  dialogue  Espacement.  Cliquez  sur  le  bouton
Catégorie et  sélectionnez  Accolades dans la  liste  déroulante.  Sélectionnez l’option
Ajuster toutes les parenthèses.

Parenthèses non appariées
Veillez à l’équilibre des parenthèses encadrant vos formules Math. Sans parenthèse pour fermer la
formule, Math place automatiquement un point d’interrogation culbuté ¿ à l’endroit où la parenthèse
aurait  dû  être  placée.  Par  exemple,  lbrace a; b donne  ¿ ,  puisqu’il  manque  l’accolade
fermante rbrace.

Ce point d’interrogation inversé disparaît une fois toutes les paires de parenthèses complètes. Pour
corriger cet exemple, il faut écrire :  lbrace a; b rbrace. On obtient ainsi  {a ;b }. Cependant,
certaines situations nécessitent l’utilisation de parenthèses dépariées. Voici plusieurs solutions pour
résoudre ce problème.

Parenthèses non ajustables
Une barre oblique inversée « \ » est placée juste avant une parenthèse non ajustable pour indiquer
que le caractère suivant  ne doit  pas être considéré comme une parenthèse mais un caractère
littéral.

Ainsi, les crochets dépariés de la formule  [ a; b [  feront apparaître un point d’interrogation
inversé car Math attend que [ soit fermé par ]. Afin d’éviter cela, dans la zone d’édition insérez une
barre oblique inversée avant chaque crochet. Vous obtenez ainsi [a ;b[.

Parenthèses ajustables
Pour créer des parenthèses ou des accolades ajustables dans une formule,  utilisez les balises
left, right et none .

Exemple
La formule suivante utilise la balise stack pour créer une formule sur deux lignes et n’utiliser
qu’un seul crochet à droite.
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abs x = left lbrace stack {x " pour " x >=
0 # -x " pour " x < 0} right none

|x|={ x  pour x≥0
−x  pour x<0

Ce résultat est obtenu à l’aide des balises left lbrace et right none. La balise lbrace
indique à Math la présence d’une accolade ouvrante, tandis que la balise right none prend
la place de l’accolade fermante pour permettre un affichage sans erreur.

Reconnaissance des fonctions
Dans l’installation par défaut, Math affiche les variables en italique et les fonctions en caractères
droits. Si Math ne reconnaît pas une fonction, vous pouvez le signaler. Utilisez la balise func juste
avant la fonction pour forcer la reconnaissance du texte qui suit comme fonction.

Pour accéder à la liste complète des fonctions de Math, veuillez consulter l’Annexe A  Références
des Commandes.

Certaines  fonctions  de  Math  doivent  être  suivies  d’un  nombre  ou  d’une  variable.  Sinon,  Math
remplacera ces fonctions par un point d’interrogation culbuté que vous pouvez retirer en corrigeant
la formule avec un nombre, une variable ou une paire d’accolades vides.

Astuce

Pour naviguer entre les différentes erreurs, utilisez les touches F3 (erreur suivante) et
Maj+F3 (erreur précédente).

Formules sur plusieurs lignes

Pour écrire une formule sur plusieurs lignes comme : x=3
y=1

, vous seriez tenté d’appuyer simplement

sur la touche Entrée. Cependant, en appuyant sur Entrée, le balisage passe à la ligne suivante mais
la formule résultante ne le fait pas. Utilisez la balise newline pour ajouter une ligne supplémentaire
à votre formule.

Exemple
Les exemples suivants montrent comment la balise  newline peut être utilisée pour ajouter
une ligne à une formule.  Le premier  exemple n’utilise pas de balise mais  uniquement  la
touche  Entrée pour passer à la ligne, ce qui ne donne pas le résultat attendu. Le second
exemple utilise la balise newline et donne le résultat attendu.

Langage de balisage Formule obtenue

x = 3
y = 1 x=3y=1

x = 3 newline y = 1 x=3
y=1

Dans Math, il est impossible de créer une formule sur plusieurs lignes se terminant par le
signe égal sans qu’un terme ne complète la formule à droite du signe. Dans ce cas, utilisez
des guillemets vides "", des accolades vides {}, l’accent grave ` ou le tilde ˜.

Par défaut, l’alignement d’une formule sur plusieurs lignes est centré. Pour plus d’informations sur
l’alignement du signe égal, veuillez consulter Chapitre 4  Personnalisation. 
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Espacement dans les formules
L’espacement entre les éléments d’une formule n’est pas généré par les caractères d’espacement
du  langage  de  balisage.  Pour  ajouter  des  espaces  dans  vos  formules,  entrez  l’un  de  ces
caractères :

• Un accent grave ` permet d’ajouter un petit espace.

• Un tilde ~ permet d’ajouter un espace normal.

• Enfin,  vous  pouvez  ajouter  des  caractères  d’espacement  entre  des  guillemets  "".  Ces
espaces sont considérés comme du texte.

Par défaut, les espaces en fin de balisage sont ignorés. Pour plus d’informations, veuillez consulter
le Chapitre 4  Personnalisation.

Ajout de limites aux sommes et intégrales
Les balises sum et int, servent respectivement à entrer une somme et une intégrale. Pour fixer des
limites inférieures  et  supérieures à  votre somme ou votre intégrale,  vous pouvez  appliquer les
paramètres  from et  to aux balises sum et int. Les paramètres  from et  to peuvent être utilisés
indépendamment  l’un  de  l’autre,  ou  par  paire,  comme dans  les  exemples  suivants.  Pour  plus
d’informations sur les balises sommes et intégrales, veuillez consulter l’Error: Reference source not
found.

Exemples
Les exemples suivants montrent comment ajouter des limites supérieures et inférieures aux
sommes et aux intégrales. Vous pouvez utiliser des parenthèses pour définir explicitement les
parties auxquelles les limites doivent s’appliquer.

Langage de balisage Formule obtenue

sum from {k = 1} to n a_k ∑
k=1

n

ak

sum to infinity 2^{-n}
∑
∞

2−n

sum from{ i=1 } to{ n } sum
from{ j=1; i <> j } to{ m } x_ij ∑

i=1

n

∑
j=1;i≠ j

m

x ij

int from 0 to x f(t) dt ∫
0

x

f (t )dt

int_0^x f(t) dt ∫0

x
f (t)dt

int from Re f ∫
ℜ

f

Parenthèses non appariées
Veillez à l’équilibre des parenthèses encadrant vos formules Math. Sans parenthèse pour fermer la
formule, Math place automatiquement un point d’interrogation culbuté ¿ à l’endroit où la parenthèse
aurait  dû  être  placée.  Par  exemple,  lbrace a; b donne  ¿ ,  puisqu’il  manque  l’accolade
fermante rbrace.

Ce point d’interrogation inversé disparaît une fois toutes les paires de parenthèses complètes. Pour
corriger cet exemple, il faut écrire :  lbrace a; b rbrace. On obtient ainsi  {a ;b }. Cependant,
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certaines situations nécessitent l’utilisation de parenthèses dépariées. Voici plusieurs solutions pour
résoudre ce problème.

Parenthèses non ajustables
Une barre oblique inversée « \ » est placée juste avant une parenthèse non ajustable pour indiquer
que le caractère suivant  ne doit  pas être considéré comme une parenthèse mais un caractère
littéral.

Ainsi, les crochets dépariés de la formule  [ a; b [  feront apparaître un point d’interrogation
inversé car Math attend que [ soit fermé par  ]. Afin d’éviter cela, dans la zone d’édition, insérez
une barre oblique inversée avant chaque crochet. Vous obtenez ainsi [a ;b[.

Parenthèses ajustables
Pour créer des parenthèses ou des accolades ajustables dans une formule,  utilisez les balises
left, right et none .

Exemple
La formule suivante utilise la balise stack pour créer une formule sur deux lignes et n’utiliser
qu’un seul crochet à droite.

abs x = left lbrace stack {x " pour " x 
>= 0 # -x " pour " x < 0} right none

|x|={ x  pour x≥0
−x  pour x<0

Ce résultat est obtenu à l’aide des balises left lbrace et right none. La balise lbrace
indique à Math la présence d’une accolade ouvrante, tandis que la balise right none prend
la place de l’accolade fermante pour permettre un affichage sans erreur.

Reconnaissance des fonctions
Dans l’installation par défaut, Math affiche les variables en italique et les fonctions en caractères
droits. Si Math ne reconnaît pas une fonction, vous pouvez le signaler. Utilisez la balise func juste
avant la fonction pour forcer la reconnaissance du texte qui suit comme fonction.

Pour accéder à la liste complète des fonctions de Math, veuillez consulter l’Annexe A  Références
des Commandes.

Certaines  fonctions  de  Math  doivent  être  suivies  d’un  nombre  ou  d’une  variable.  Sinon,  Math
remplacera ces fonctions par un point d’interrogation culbuté que vous pouvez retirer en corrigeant
la formule avec un nombre, une variable ou une paire d’accolades vides.

Astuce

Pour naviguer entre les différentes erreurs, utilisez les touches F3 (erreur suivante) et
Maj+F3 (erreur précédente).

Formules sur plusieurs lignes

Pour écrire une formule sur plusieurs lignes comme : x=3
y=1

, vous seriez tenté d’appuyer simplement

sur la touche Entrée. Cependant, en appuyant sur Entrée, le balisage passe à la ligne suivante mais
la formule résultante ne le fait pas. Utilisez la balise newline pour ajouter une ligne supplémentaire
à votre formule.
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Exemple
Les exemples suivants montrent comment la balise  newline peut être utilisée pour ajouter
une ligne à une formule.  Le premier  exemple n’utilise pas de balise mais  uniquement  la
touche  Entrée pour passer à la ligne, ce qui ne donne pas le résultat attendu. Le second
exemple utilise la balise newline et donne le résultat attendu.

Langage de balisage Formule obtenue

x = 3
y = 1 x=3y=1

x = 3 newline y = 1 x=3
y=1

Dans Math, il est impossible de créer une formule sur plusieurs lignes se terminant par le
signe égal sans qu’un terme ne complète la formule à droite du signe. Dans ce cas, utilisez
des guillemets vides "", des accolades vides {}, l’accent grave ` ou le tilde ˜.

Par défaut, l’alignement d’une formule sur plusieurs lignes est centré. Pour plus d’informations sur
l’alignement du signe égal, veuillez consulter Chapitre 4  Personnalisation. 

Espacement dans les formules
L’espacement entre les éléments d’une formule n’est pas généré par les caractères d’espacement
du  langage  de  balisage.  Pour  ajouter  des  espaces  dans  vos  formules,  entrez  l’un  de  ces
caractères :

• Un accent grave ` permet d’ajouter un petit espace.

• Un tilde ~ permet d’ajouter un espace normal.

• Enfin,  vous  pouvez  ajouter  des  caractères  d’espacement  entre  des  guillemets  "".  Ces
espaces sont considérés comme du texte.

Par défaut, les espaces en fin de balisage sont ignorés. Pour plus d’informations, veuillez consulter
le Chapitre 4  Personnalisation.

Ajout de limites aux sommes et intégrales
Les balises sum et int, servent respectivement à entrer une somme et une intégrale. Pour fixer des
limites inférieures  et  supérieures à  votre somme ou votre intégrale,  vous pouvez  appliquer les
paramètres  from et  to aux balises sum et int. Les paramètres  from et  to peuvent être utilisés
indépendamment  l’un  de  l’autre,  ou  par  paire,  comme dans  les  exemples  suivants.  Pour  plus
d’informations sur les balises sommes et intégrales, veuillez consulter l’Error: Reference source not
found.

Exemples
Les exemples suivants montrent comment ajouter des limites supérieures et inférieures aux
sommes et aux intégrales. Vous pouvez utiliser des parenthèses pour définir explicitement les
parties auxquelles les limites doivent s’appliquer.

Langage de balisage Formule obtenue

sum from {k = 1} to n a_k ∑
k=1

n

ak

sum to infinity 2^{-n}
∑
∞

2−n
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sum from{ i=1 } to{ n } sum
from{ j=1; i <> j } to{ m } x_ij ∑

i=1

n

∑
j=1;i≠ j

m

x ij

int from 0 to x f(t) dt ∫
0

x

f (t )dt

int_0^x f(t) dt ∫0

x
f (t)dt

int from Re f ∫
ℜ

f

Écriture des dérivées
Lorsque vous écrivez une dérivée, vous devez indiquer à Math qu’il s’agit d’une fraction. Pour cela,
utilisez la balise  over.  Si vous souhaitez écrire une dérivée totale, utilisez la balise  over et le
caractère  d.  Si  vous  souhaitez  écrire  une  dérivée  partielle,  utilisez  la  balise  over  et  la  balise
partial. Lorsque vous rédigez votre dérivée, encadrez ses éléments par des accolades {} pour
qu’ils s’affichent correctement, comme dans les exemples suivants.

Exemples
Exemples d’écriture de dérivées dans Math :

Langage de balisage Formule obtenue

{df} over {dx} df
dx

{partial f} over {partial y} ∂f
∂y

{partial^2 f} over {partial t^2} ∂2 f
∂t2

Remarque

Pour écrire un nom de fonction avec le symbole prime, comme en notation scolaire
habituelle, vous devez d’abord l’ajouter au catalogue des symboles. Veuillez consulter
Chapitre 4  Personnalisation pour plus d’informations.

Caractères de balisage en tant que caractères normaux
Certains caractères sont utilisés en tant que caractères de contrôle de balise. Cela veut dire que si
vous les entrez dans votre formule, Math ne les affichera pas tels quels. Voici les caractères en
question : %, {, }, &, |, _, ^ et ". Par exemple, si vous tapez 2 %=0,02 dans la zone d’édition de
Math, la formule affichée sera erronée. Pour pallier cette limitation du langage de balisage, utilisez
une des méthodes suivantes :

• Pour que Math affiche votre caractère dans la formule tel que vous l’avez tapé, vous devez
encadrer  ce  caractère  par  des  guillemets  droits,  par  exemple  2"%"= 0,02 s’affichera
comme ceci :  2%=0,02. Cependant, cette méthode ne fonctionne pas pour les doubles
guillemets eux-mêmes, veuillez consulter “Texte dans une formule” plus bas.
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• Ajoutez  le  caractère  dont  vous  avez  besoin  au  catalogue  des  symboles  de  Math  (par
exemple, le caractère de guillemets droits).

• Utilisez des balises. Par exemple, lbrace et rbrace génèrent des accolades {}.

Remarque

La boîte de dialogue Caractères spéciaux utilisée dans les autres modules LibreOffice
n’est  pas  disponible  dans  Math.  Si  vous  utilisez  régulièrement  certains  caractères
spéciaux,  nous  vous  conseillons  de  les  ajouter  au  catalogue  de  Math.  Pour  plus
d’informations, veuillez consulter Chapitre 4  Personnalisation.

Texte dans une formule
Pour insérer un texte dans une formule, il  suffit  de l’entourer de guillemets droits,  par exemple
x " pour " x >= 0 en langage balisé donnera la formule x  pour x≥0. Tous les caractères, à
l’exception des dés guillemets droits, peuvent être utilisés dans un texte.

En cas de nécessité, il est possible de copier-coller des doubles guillemets depuis LibreOffice Writer
dans l’éditeur  de formule,  comme dans la  Figure  7:  Exemple  de guillemets doubles  dans une
formule.

La police d’écriture du texte de formule est définie par défaut dans la boîte de dialogue Polices.
Pour  plus  d’informations  concernant  les  modifications  de  polices  d’écriture,  veuillez  consulter
“Modification de l’apparence des formules” à la page 27.

Par défaut, le texte est justifié à gauche dans les formules. Pour plus d’informations concernant la
modification d’alignement de texte, veuillez consulter “Ajustement de l’alignement des formules” à la
page 34.

Figure 7: Exemple de guillemets doubles dans une formule

Formatage du texte dans des formules
Les balises de formatages ne sont pas interprétées comme telles lorsqu’elles sont écrites dans des
formules. Pour utiliser des balises de formatage dans des formules, entourez le texte à l’aide des
doubles guillemets dans l’éditeur de formule.

Exemple
Écrire le texte suivant dans l’éditeur de formule :

"Dans les triangles " color blue bold "isocèles" ", les angles de la
base sont égaux."
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donne le texte suivant dans une formule :
Dans les triangles isocèles , les angles de la base sont égaux..

Cet  exemple  montre  comment  utiliser  les  balises  color et  bold pour  formater  le  mot
« isocèles ».  Notez  que  ces  balises  sont  appliquées  au  texte  qui  suit  directement  entre
guillemets.  Ainsi,  les balises de formatage ne peuvent  s’appliquer au  reste du texte dans
l’exemple, car il est dans un autre bloc.

La balise color doit être suivie du nom de la couleur désirée. Vous pouvez vous référer à l’Annexe
A  Références des Commandes pour une liste des noms de couleurs prédéfinis.

Alignement des formules avec le signe égal
LibreOffice Math ne propose pas de balises pour aligner les formules sur un caractère particulier.
Vous  pouvez  cependant  utiliser  une  matrice  pour  aligner  les  formules  à  un  caractère,  qui  est
généralement  le  signe  égal  (=).  De  plus,  vous pouvez utiliser  les  balises  alignr,  alignl et
alignc pour  définir  l’alignement de chaque valeur  dans la  matrice,  respectivement à droite,  à
gauche ou au centre.

Exemple
Ci-dessous un exemple de matrice pour aligner des formules au signe égal. Notez que les
balises d’alignement alignent le contenu de chaque position dans la matrice.

matrix{ alignr x+y # {}={} # alignl 2 ## 
alignr x # {}={} # alignl 2-y }

x+ y = 2
x = 2−y

Remarque

Les accolades vides autour du signe égal sont nécessaires, car le signe égal est un
opérateur  binaire et  nécessite une expression de chaque côté.  Des espaces et  les
signes  « ' »  ou  « ~ »  peuvent  encadrer  le  signe  égal  mais  les  accolades  sont
recommandées, car elles sont plus facilement identifiables dans le langage de balisage.

L’espace  autour  du  signe  égal  peut  être  réduit  en  modifiant  l’espacement  inter-colonne  de  la
matrice. Pour plus d’informations, veuillez consulter “Ajustement de l’espacement des formules” à la
page 31.

Modification de l’apparence des formules

Taille de la police

Taille de la police actuelle
Pour modifier la taille de la police utilisée dans une formule déjà insérée dans Math ou un autre
module LibreOffice :

1. Ouvrez l’éditeur de formules. 

2. Sélectionnez  Format > Taille  de police dans le  menu principal  pour ouvrir  la  boîte de
dialogue Tailles de police (Figure 8: Boîte de dialogue Tailles de police).

3. Sélectionnez une taille de police différente à l’aide des flèches dans Taille de base ou entrez
directement une valeur.

4. Cliquer sur  OK pour enregistrer les modifications et fermer la boîte de dialogue. Voilà un
exemple pour illustrer le changement de taille de police.
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Exemple
Taille de police par défaut 12 pt : π≃3,14159

Après une modification à 18 pt : π≃3,14159

Figure 8: Boîte de dialogue Tailles de police

Taille de police par défaut
Pour changer la taille de police par défaut utilisée dans toutes les nouvelles formules de Math ou
autre module LibreOffice :

1. Avant d’insérer la première formule dans votre document, sélectionnez le menu Format >
Taille de police depuis la barre de menu principal pour ouvrir la boîte de dialogue Tailles de
police (Figure 8: Boîte de dialogue Tailles de police).

2. Sélectionnez une taille de police différente à l’aide du bouton fléché ou entrez directement
une valeur.

3. Cliquez sur Par défaut et confirmez la modification de la taille de police. Toute formule créée
suite à cette modification utilisera la nouvelle taille de police par défaut paramétrée.

4. Cliquez sur OK pour sauvegarder les modifications et fermer la boîte de dialogue.

Remarque

Si vous avez déjà inséré des formules dans votre document et que vous changez la
taille de base par défaut, seules les nouvelles formules créées après le changement
utiliseront  ce nouveau réglage par  défaut.  Si  vous voulez utiliser  la  même taille  de
police de base, il vous faut modifier individuellement la taille de police des formules déjà
écrites.

Astuce

Il existe une extension FaF « Formatting of All Math Formulas » (Formatage de toutes
les formules Math). Elle permet de modifier la police et la taille de police de toutes les
formules ou uniquement celles sélectionnées. L’extension peut être téléchargée sur le
site  officiel  des  extensions :  https://extensions.libreoffice.org/extensions/formatting-of-
all-math-formulas
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Options de taille de police
La boîte de dialogue Tailles de police (Figure 8: Boîte de dialogue Tailles de police) définit les tailles
de police de votre formule. Sélectionnez une taille de base pour redimensionner tous les éléments
de la formule.

• Taille de base – tous les éléments de la formule sont redimensionnés par rapport à cette
taille de base.  Pour modifier la taille de base, sélectionnez ou tapez la taille désirée en
point (pt). Vous pouvez également utiliser d’autres unités de mesure ou métriques qui seront
automatiquement converties en points.

• Tailles relatives – dans cette section, vous pouvez définir les tailles relatives de chaque
type d’élément par rapport à la taille de base.

– Texte  : sélectionne la taille du texte dans les formules, proportionnelle à la taille de base.
– Indices et exposants : sélectionne la taille pour les indices et exposants, proportionnelle

à la taille de base.
– Fonctions : sélectionne la taille des fonctions et de leurs éléments, proportionnelle à la

taille de base.
– Opérateurs : sélectionne la taille pour les opérateurs mathématiques, proportionnelle à la

taille de base.
– Limites : sélectionne la taille pour les limites dans une formule, proportionnelle à la taille

de base. Cela correspond aux commandes telles que  from et  to,  utilisées pour les
sommes et les intégrales.

• Par défaut – Cliquez sur ce bouton pour sauvegarder les modifications en tant que valeurs
par défaut pour toutes les nouvelles formules créées. Un message de confirmation apparaît
avant l’enregistrement des modifications.

Polices de formule

Polices de la formule en cours
Pour  modifier  les  polices  utilisées  dans  une  formule  en  cours  sur  Math  ou  un  autre  module
LibreOffice :

1. Ouvrez l’Éditeur de formule. 

2. Dans le menu principal, sélectionnez Format > Polices pour ouvrir la boîte de dialogue des
polices (Figure 9 : Boîte de dialogue des polices d'écriture).

3. Sélectionnez  une  nouvelle  police  pour  chacune  des  nombreuses  options  du  menu
déroulant.

4. Si  la  police  que vous souhaitez  utiliser  n’est  pas  dans  la  liste,  cliquez  sur  Modifier et
sélectionnez l’option du menu contextuel pour ouvrir  une nouvelle boîte de dialogue des
polices. Sélectionnez la police souhaitée et cliquez sur OK pour l’ajouter au menu déroulant.

5. Cliquez sur OK pour enregistrer les modifications et fermer la fenêtre.
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Figure 9  : Boîte de dialogue des polices d'écriture

Polices par défaut
Pour modifier les polices par défaut des formules de Math ou d’un autre module LibreOffice :

1. Avant d’insérer une formule dans votre document, ouvrez la boîte de dialogue des polices
d’écriture, dans Format > Polices (Figure 9 : Boîte de dialogue des polices d'écriture).

2. Sélectionnez  une  nouvelle  police  pour  chacune  des  options  disponible  dans  la  liste
déroulante.

3. Si  la  police  que vous souhaitez  utiliser  n’est  pas  dans  la  liste,  cliquez  sur  Modifier et
sélectionnez l’option du menu contextuel pour ouvrir  une nouvelle boîte de dialogue des
polices. Sélectionnez la police souhaitée et cliquez sur OK pour l’ajouter au menu déroulant.

4. Cliquez sur  Par défaut et confirmez les modifications. Chaque formule créée par la suite
utilisera la nouvelle police d’écriture.

5. Cliquez sur OK pour enregistrer les modifications et fermer la fenêtre.

Remarque

Si  des  formules  ont  déjà  été  insérées,  seules  les  formules  insérées  après  les
modifications auront la nouvelle police par défaut. Vous devez modifier manuellement la
police de chaque formule déjà insérée si vous souhaitez qu’elles aient la même police
que la nouvelle police par défaut.

Astuce

L’extension FaF « Formatting of All Math Formulas » (Formatage de toutes les formules
Math) peut être utilisée pour modifier la police de toutes les formules du document.
Cependant, n’oubliez pas que la police sélectionnée dans l’extension sera appliquée
aux Variables, Fonctions, Nombres et Texte. Pour télécharger l’extension, rendez-vous
à l’adresse : https://extensions.libreoffice.org/extensions/formatting-of-all-math-formulas
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Options de polices de formules
La boîte de dialogue Polices définit les polices pouvant être appliquées aux éléments des formules.

• Polices des formules – Définit les polices utilisées pour les variables, fonctions, nombres
et texte inséré qui composent les éléments d’une formule.

– Variables – sélectionne les polices des variables d’une formule. Par exemple, dans la
formule x=SIN(y), x et y sont des variables, leur police sera modifiée.

– Fonctions –  sélectionne  les  polices  pour  les  noms  et  propriétés  des  fonctions.  Par
exemple, les fonctions dans la formule x=SIN(y) sont =SIN().

– Nombres – sélectionne les polices pour les nombres dans une formule.
– Texte – définit la police pour le texte d’une formule. 

• Polices personnalisées – cette section de la boîte de dialogue Polices (Figure 9 : Boîte de
dialogue des polices d'écriture) définit  la police pour formater les composants d’un texte
d’une formule. Les trois polices de base, Serif, Sans-serif et  Largeur fixe sont disponibles.
D’autres polices peuvent être ajoutées à chaque police de base en cliquant sur le bouton
Modifier. Chaque police installée sur le système de l’ordinateur peut être utilisée.

– Serif –  indique  quelle  police  utiliser  pour  le  balisage  font serif.  Les  serifs
(empattements  en  français)  sont  les  petites  « extensions »  que  l’on  retrouve,  par
exemple, sous la lettre majuscule A avec la police Times serif. Utiliser des serifs peut
s’avérer très utile pour relier les lettres en ligne droite et accélérer la lecture.

– Sans-serif – indique la police à utiliser pour le balisage font sans.
– Largeur fixe – indique la police à utiliser pour le balisage font fixed.

• Modifier – cliquez sur l’une des options du menu contextuel pour accéder à  une nouvelle
boîte de dialogue des polices, où les polices et attributs peuvent être définis pour chaque
formule et police personnalisée.

• Par défaut – Cliquez sur ce bouton pour sauvegarder les modifications en tant que valeurs
par défaut pour toutes les nouvelles formules créées. Un message de confirmation apparaît
avant l’enregistrement des modifications.

Remarque

Lorsqu’une nouvelle police est sélectionnée pour une formule, les anciennes polices
restent disponibles dans la liste et peuvent être sélectionnées à nouveau.

Par convention, les variables devant être écrites en italique, assurez-vous que l’option
Italique est sélectionnée pour la police que vous souhaitez utiliser. Pour tous les autres
éléments, utiliser la forme de base de la police. Le style peut être modifié directement
dans les formules en utilisant  les commandes  italic et  bold pour  les  activer  et
nitalic et nbold pour les désactiver.

Ajustement de l’espacement des formules
Utilisez  la  boîte  de  dialogue  Espacement  (Figure  10 :  Boîte  de  dialogue  d'espacement)  pour
paramétrer l’espacement entre les éléments de la formule. L’espacement est renseigné avec un
pourcentage lié à la taille basique prédéfinie des polices.
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Figure 10 : Boîte de dialogue d'espacement

Espacement de la formule active
Pour  changer  l’espacement  utilisé  pour  la  formule  active  dans  Math  ou  un  autre  module
LibreOffice :

1. Cliquez sur le langage de balisage dans l’Éditeur de formule.

2. Allez dans Format > Espacement dans la barre de menu pour ouvrir la boîte de dialogue
(Figure 10 : Boîte de dialogue d'espacement).

3. Cliquez sur Catégorie et sélectionnez une des options dans la liste déroulante. Les options
de la boîte de dialogue Espacement changent selon la catégorie sélectionnée.

4. Entrez les nouvelles valeurs dans la catégorie espacement et cliquez sur OK

5. Vérifiez le résultat dans votre formule.  S’il  ne vous convient  pas, répétez les étapes ci-
dessus.

Espacement par défaut de la formule
Pour changer l’espacement par défaut  utilisé pour toutes les formules dans Math ou tout  autre
module LibreOffice :

1. Avant d’insérer une formule dans votre document, allez dans Format > Espacement dans
la  barre  de  menu  pour  ouvrir  la  boîte  de  dialogue  (Figure  10 :  Boîte  de  dialogue
d'espacement).

2. Cliquez sur Catégorie et sélectionnez une des options dans la liste déroulante. Les options
de la boîte de dialogue Espacement changent selon la catégorie sélectionnée.

3. Cliquez sur  Par défaut et confirmez les changements de l’espacement de formule. Toute
formule créée utilisera désormais le nouvel espacement pour formule.

4. Cliquez  sur  OK pour  sauvegarder vos  changements  et  fermer  la  boîte  de  dialogue
Espacement.

Remarque

Si  vous avez déjà  inséré  des formules  dans votre  document  et  que vous modifiez
l’espacement,  seules  les  formules  insérées  après  la  modification  appliqueront  les
paramètres par défaut. Vous devez modifier manuellement l’espacement des formules
déjà insérées pour qu’elles soient espacées par défaut.

Options d’espacement
Utilisez  Catégorie  dans  la  boîte  de  dialogue  Espacement  (Figure  10 :  Boîte  de  dialogue
d'espacement)  pour  déterminer  quel  type  d’élément  vous  souhaitez  modifier  l’espacement.
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L’apparence de la boîte de dialogue dépend de la catégorie choisie. Une fenêtre de prévisualisation
vous montre quel espacement est modifié à travers les boîtes respectives.

• Catégorie –  ce  bouton  permet  de  choisir  la  catégorie  dont  vous  souhaitez  modifier
l’espacement.

• Espacement – définit l’espacement entre les variables et les opérateurs, entre les lignes et
entre la racine et les radicaux.

– Espacement – détermine l’espacement entre les variables et les opérateurs
– Interligne – détermine l’espacement entre les lignes
– Espacement de la racine – détermine l’espacement entre les racines et les radicaux.

• Index – définit l’espacement pour les index d’exposants et d’indices.

– Exposant – détermine l’espacement pour les index d’exposants.
– Indice – détermine l’espacement pour les index d’indices.

• Fractions –  définit  l’espacement  entre  la  barre  de  fraction  et  le  numérateur  ou  le
dénominateur.

– Numérateur – détermine l’espacement entre la barre de fraction et le numérateur.
– Dénominateur – détermine l’espacement entre la barre de fraction et le dénominateur.

• Barres de fraction –  définit  le  dépassement  de  longueur  et  l’épaisseur  de  la  barre  de
fraction.

– Dépassement  de  longueur –  détermine  le  dépassement  de  longueur  de  la  barre  de
fraction.

– Épaisseur – détermine l’épaisseur de la barre de fraction.
• Limites – définit l’espacement entre le symbole somme ou intégrale et les conditions aux

limites.

– Limite supérieure – détermine l’espacement entre le symbole et la limite supérieure.
– Limite inférieure – détermine l’espacement entre le symbole et la limite inférieure.

• Accolades – définit l’espacement entre les accolades et les contenus.

– Dépassement de taille (droite/gauche) – détermine la  distance verticale entre le  bord
supérieur des contenus et l’extrémité supérieure de l’accolade.

– Espacement –  détermine  la distance  horizontale  entre  les  contenus  et  l’extrémité
supérieure de l’accolade.

– Ajuster toutes les parenthèses – ajuste tous les types de parenthèses. Si vous entrez (a
over b) dans l’Éditeur de formules, les parenthèses vont entourer la hauteur totale de
l’argument.  Vous  obtenez  normalement  ce  résultat  en  entrant  left ( a over b
right ).

– Dépassement  de  taille –  ajuste  le  pourcentage  de  dépassement  de  taille.  Si  le
pourcentage est à zéro, les accolades sont paramétrées pour entourer l’argument à la
même hauteur. Plus la valeur entrée est grande, plus l’écart vertical entre les contenus
de l’accolade et la bordure extérieure de l’accolade est grand. Ce champ ne peut être
utilisé qu’en conjonction avec Ajuster toutes les parenthèses.

• Matrices – définit l’espacement relatif pour les éléments d’une matrice.

– Interligne – détermine l’espacement entre les lignes de la matrice.
– Espacement  entre  les  colonnes –  détermine  l’espacement  entre  les  éléments  de  la

matrice sur une ligne.
• Symboles – définit l’espacement des symboles par rapport aux variables.

– Hauteur primaire – définit la hauteur des symboles par rapport à la ligne de base.
– Espacement  minimum –  détermine  la  distance  minimum  entre  un  symbole  et  une

variable.
• Opérateurs – définit l’espacement entre les opérateurs et les variables ou les nombres.

– Dépassement de taille – détermine la hauteur de la variable jusqu’au bord supérieur de
l’opérateur.

– Espacement – détermine la distance horizontale entre les opérateurs et les variables.
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• Bordures –  définit l’espacement entre les bordures et la formule.  Cette bordure doit être
ajoutée via les propriétés de l’objet formule (dans Writer, sélectionnez le menu  Format >
Cadre et objet > Propriétés) Cette option est particulièrement utile si vous désirez intégrer
une  formule  dans  un  fichier  texte  dans  LibreOffice Writer  en  combinant  des  formules
mathématiques et du texte dans le même paragraphe.

– Gauche –  définit en point l’espacement entre la bordure gauche et la formule.
– Droite – définit en point l’espacement entre la bordure droite et la formule.
– Haut – définit en point l’espacement entre la bordure supérieure et la formule.
– Bas – définit en point l’espacement entre la bordure inférieure et la formule.

• Champ d’aperçu – affiche un aperçu de la sélection active.

• Par défaut – enregistre les modifications comme paramètres par défaut pour toute nouvelle
formule. Un message de sécurité s’affiche avant l’enregistrement de ces modifications.

Remarque

Si vous ajoutez des formules  mathématiques dans un document  LibreOffice  Writer,
vous devriez remarquer un espacement entre la formule et le texte qui l’entoure même
si les bordures de la formule sont paramétrées à zéro. Cela s’explique par le fait que les
formules Math sont des objets OLE incorporés dans un cadre qui, par défaut, ajoute
0,2 cm  à  droite  et  à  gauche  de  l’objet  Math.  Pour  retirer  cet  espacement
supplémentaire, vous avez deux options. La première option est d’éditer les propriétés
de l’objet avec un clic droit sur l’objet Math puis aller dans Propriétés > Adaptation du
texte et ajuster les champs  Espacement pour paramétrer les valeurs souhaitées. La
seconde option est de modifier les options d’espacement par défaut du Style de Cadre
de la Formule ou en créer un nouveau à partir de zéro. Pour plus d’informations sur la
modification d’espacement d’objets Math, référez-vous à la section Espacement d’objet
dédiée  dans  ce  guide.  Pour  plus  d’informations  sur  l’édition  de  styles  en  général,
référez-vous aux chapitres Styles dans le guide Writer.

Exemple
Dans l’exemple  qui  suit,  les  objets  Math sont  combinés avec du texte  en supprimant  les
espacements  de la  formule  et  du style  de cadre  qui  l’entoure.  Puisque l’espacement  est
paramétré  à  zéro,  l’espacement  entre  le  texte  et  les  formules  est  réalisé  en ajoutant  un
caractère d’espace inséré grâce à la barre d’espace du clavier.

“Soit  cij la  matrice  de  coût  et  xij∈{0 ;1}la  variable  de  décision  ayant  pour  origines

i=1,2 , ... ,m et pour destinations j=1,2 , ... ,n”.

Ajustement de l’alignement des formules
Les paramètres d’alignement déterminent comment sont placés les éléments de formule les uns au-
dessus des autres et alignés horizontalement les uns à côté des autres.

Remarque

Il n’est pas possible d’aligner des formules sur un caractère particulier et l’alignement
de formules  ne s’applique pas aux éléments  de texte.  Les  éléments de texte sont
toujours alignés à gauche.

Alignement de la formule active
Pour  modifier  l’alignement utilisé pour une formule active dans Math ou dans un autre module
LibreOffice :

1. Cliquez sur le langage de balisage dans l’Éditeur de formule.
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2. Allez dans  Format > Alignement dans la barre de menu pour ouvrir la boîte de dialogue
Alignement (Figure 11 : Boîte de dialogue Alignement).

3. Sélectionnez Gauche, Centré, ou Droite pour l’alignement horizontal.

4. Cliquez sur OK et vérifiez le résultat sur votre formule. Si vous n’êtes pas satisfait, répétez
les étapes ci-dessus.

Figure 11 : Boîte de dialogue Alignement

Remarque

Hormis l’option d’alignement sélectionnée dans la boîte de dialogue Alignement, il est
possible d’aligner les sections d’une formule en utilisant les balises alignl, alignc et
alignr.  Par exemple,  elles peuvent être utiles pour aligner des formules dans des
matrices. Ces commandes peuvent être utilisées pour les éléments de texte.

Alignement de la formule par défaut
Pour changer l’alignement par défaut utilisé par toutes les formules dans Math ou tout autre module
LibreOffice :

1. Avant d’insérer une formule dans votre document, allez dans Format > Alignement dans la
barre de menu pour ouvrir la boîte de dialogue Alignement (Figure 11 : Boîte de dialogue
Alignement).

2. Sélectionnez Gauche, Centré, ou Droite pour l’alignement horizontal.

3. Cliquez  sur  Par  défaut et  confirmez  vos  modifications  d’alignement  de  formule.  Toute
formule créée utilisera dès à présent le nouvel alignement.

4. Cliquez sur OK et vérifiez le résultat sur votre formule. Si vous n’êtes pas satisfait, répétez
les étapes ci-dessus.

Remarque

Si  vous avez déjà  inséré  des formules  dans votre  document  et  que vous modifiez
l’alignement  d’une  formule,  seules  les  formules  insérées  après  la  modification
d’alignement  utiliseront  les  nouveaux  paramètres  par  défaut.  Vous  devez  modifier
individuellement l’alignement des formules déjà insérées si  vous souhaitez que ces
formules utilisent le même alignement que celui par défaut.
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Changer la couleur de la formule

Couleur des caractères
La couleur de formule pour les caractères utilisés peut  être modifiée en utilisant  la commande
color dans le langage de balisage. Cette commande fonctionne uniquement sur l’élément de la
formule suivant le nom de la couleur. Par exemple, entrer le langage de balisage color red 5
times 4 donne le résultat 5×4. Vous remarquez que seul le chiffre 5 est coloré en rouge.

Pour  changer  la  couleur  de  toute  la  formule,  vous  devez  inclure  la  formule  complète  entre
accolades. Par  exemple,  entrer  le langage de balisage  color red {5 times 4}  donne le
résultat 5×4.

Pour découvrir  les couleurs disponibles dans Math, référez-vous à  l’Annexe A  Références des
Commandes.

Appliquer des couleurs en utilisant des valeurs RVB
Il est également possible de personnaliser les couleurs définies en utilisant les valeurs RVB (Rouge,
Vert et Bleu) allant de 0 à 255. Pour ce faire, vous devez utiliser la commande color rgb R G B
où  R,  G  et  B  correspondent  respectivement  aux  valeurs  Rouge,  Vert  et  Bleu  de  la  couleur
souhaitée.

Exemple
Ci-dessous, un exemple où le terme « variable de décision » utilise une couleur différente, qui
est définie par les valeurs RVB 160, 82 et 45.

"Soit " x_ij " une " color rgb 160 82 45 "variable  de décision" "
dans le problème traité"

Math créera la sortie suivante :

Soit xij  une variable de décision  dans le problème traité

Remarque

Les couleurs RVB sont utilisées dans de nombreuses fonctionnalités des applications
LibreOffice.  Par  exemple,  vous pouvez utiliser  des valeurs RVB pour  paramétrer  la
couleur du texte dans LibreOffice Writer.  Pour cela,  sélectionnez le texte dont  vous
souhaitez modifier la couleur puis faites un clic droit sur la sélection. Dans le menu
contextuel, allez dans Caractère > Caractère > Effets de caractère et dans le menu
déroulant  Couleur  de  police,  choisissez  Couleurs  personnalisées.  Vous  êtes  en
mesure de paramétrer la couleur du texte avec des valeurs RVB.

Couleur d’arrière-plan
Il est impossible de sélectionner une couleur d’arrière-plan pour les formules dans LibreOffice Math.
La couleur d’arrière-plan pour une formule est par défaut la même couleur que celle du document
ou du cadre dans lequel elle a été insérée. Dans les documents LibreOffice, vous pouvez utiliser les
propriétés  d’objet  pour  modifier  la  couleur  de  l’arrière-plan  pour  une  formule.  Pour  plus
d’informations, référez-vous à la section Trame de fond et bordures dans ce guide.

Bibliothèque de formules

Si vous insérez régulièrement les mêmes formules dans vos documents, vous pouvez créer une
bibliothèque de formules créées dans l’Éditeur de formules. Les formules individuelles peuvent être
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enregistrées  dans  des  fichiers  séparés  en  utilisant  un  format  ODF  pour  formules  avec  une
extension .odf ou dans un format MathML avec une extension .mml.

Vous pouvez constituer votre bibliothèque de formules à partir de LibreOffice Math, Writer, Calc,
Draw ou Impress.

À partir de Math
1. Créez un dossier sur votre ordinateur pour accueillir  vos formules et donnez-lui un nom

explicite, par exemple Bibliothèque de formules.

2. Dans LibreOffice,  allez dans  Fichier > Nouveau > Formule dans la barre de menu, ou
cliquez sur  Formule Math dans l’écran d’accueil LibreOffice puis créez votre formule en
utilisant l’Éditeur de formules. Veuillez consulter Insertion d’une formule dans un document
LibreOffice à la page 12 pour plus d’informations.

3. Dans la barre de menu, cliquez sur  Fichier > Enregistrer sous ou utilisez le raccourci
clavier Ctrl+Maj+S pour ouvrir la boîte de dialogue Enregistrer sous.

4. Naviguez jusqu’au dossier que vous avez créé pour votre bibliothèque de formules.

5. Donnez un nom explicite à votre formule dans la boîte de texte Nom du fichier.

6. Dans la liste déroulante Type de fichier, sélectionnez Formule ODF (.odf) ou MathML 2.0
(.mml) pour le type de fichier de votre formule.

7. Cliquez  sur  Enregistrer pour  enregistrer  votre  formule  et  fermer  la  boîte  de  dialogue
Enregistrer sous.

Remarque

MathML 2.0 est l’abréviation de Mathematical Markup Language (MathML) Version 2.0.
Le MathML est un format XML qui décrit la notation mathématique et permet l’utilisation
d’objets mathématiques sur le World Wide Web. Pour plus d’informations sur le format
MathML, consultez le site officiel à l’adresse
https://www.w3.org/TR/MathML2/overview.html

À partir de Writer, Calc, Draw ou Impress
1. Créez un dossier sur votre ordinateur pour accueillir  vos formules et donnez-lui un nom

explicite, par exemple Bibliothèque de formules.

2. Ouvrez un document avec Writer, Calc, Draw ou Impress.

3. Allez dans  Insertion > Objet > Formule dans la barre de menu pour ouvrir  l’Éditeur de
formules  et  créer  votre  formule.  Veuillez  consulter Insertion  d’une  formule  dans  un
document LibreOffice à la page 12 pour plus d’informations.

4. Faites un clic droit sur l’objet formule et sélectionnez  Enregistrer la copie sous dans le
menu contextuel pour ouvrir la boîte de dialogue Enregistrer sous.

5. Naviguez jusqu’au dossier que vous avez créé pour votre bibliothèque de formules.

6. Donnez un nom explicite à votre formule dans la boîte de texte Nom du fichier.

7. Dans la liste déroulante Type, sélectionnez ODF Formula (.odf) or MathML 2.0 (.mml) pour
le type de fichier de votre formule.

8. Cliquez  sur  Enregistrer pour  enregistrer  votre  formule  et  fermer  la  boîte  de  dialogue
Enregistrer sous.
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Utilisation de votre bibliothèque de formules
Vous ne pouvez pas glisser-déposer une formule depuis votre bibliothèque de formules dans un
document, ni utiliser  Insertion > Fichier dans la barre de menu. Vous devez insérer une formule
depuis votre bibliothèque en tant qu’objet OLE.

1. Ouvrez votre document avec Writer, Calc, Draw ou Impress.

2. Allez dans  Insertion > Objet > Objet OLE dans la barre de menu pour ouvrir la boîte de
dialogue Insérer un objet OLE.

3. Sélectionnez l’option Créer à partir d’un fichier.

4. Cliquez sur Rechercher pour ouvrir votre fichier dans l’explorateur de fichiers.

5. Naviguez jusqu’au dossier que vous avez créé pour votre bibliothèque de formules.

6. Sélectionnez la formule que vous souhaitez insérer et cliquez sur Ouvrir, ou double-cliquez
sur la formule que vous souhaitez insérer.

7. Cliquez sur  OK pour insérer votre formule en tant qu’objet OLE dans votre document et
fermer la boîte de dialogue d’objet OLE.
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Chapitre 2 
Les formules dans Writer



Introduction

Quand une formule est insérée dans un document LibreOffice Writer, le logiciel insère la formule
dans un cadre et  la  traite  comme un objet  OLE. Double-cliquer sur une formule insérée ouvre
l’Éditeur de formules dans LibreOffice Math afin que vous puissiez l’éditer. Pour plus d’informations
concernant la création et l’édition de formules, référez-vous au  Chapitre 1 Création et édition de
formules.

Ce chapitre explique quelles options sont modifiables pour chaque formule individuelle au sein du
document  Writer.  Référez-vous  aux  chapitres  sur  les  styles  dans  le  Guide  Writer pour  savoir
comment modifier les paramètres par défaut des styles de cadre des objets OLE.

Numérotation automatique de la formule

La numérotation automatique des formules pour servir de renvoi peut seulement être réalisée dans
LibreOffice  Writer.  La  façon la  plus  simple  d’ajouter  des  formules  numérotées dans  l’ordre  est
d’utiliser l’entrée d’AutoTexte nf (pour 'numérotation de formules').

Remarque

Le nom de l’AutoTexte dépend de la locale utilisée. Dans la plupart des autres locales
l’AutoTexte s’appelle fn.

Numérotation
1. Insérez une nouvelle ligne dans votre document

2. Tapez  nf puis appuyez sur  F3. Un tableau à deux colonnes sans bordure est inséré dans
votre document. La colonne gauche contient un exemple de formule et la colonne droite
contient un nombre de référence, comme montré ci-dessous.

E=mc2 (1)

3. Supprimez l’exemple de formule et insérez votre formule en tant qu’objet dans la colonne
gauche.  Veuillez  consulter  le Chapitre  1  Création  et  édition  de  formules pour  plus
d’informations sur l’insertion des formules.

4. Vous pouvez également insérer votre formule dans le document, puis réaliser les étapes 1
et 2 ci-dessus en remplaçant l’exemple de formule avec votre formule.

Renvoi
1. Dans votre document, cliquez à l’endroit où vous souhaitez faire apparaître un renvoi.

2. Aller  dans  Insertion > Renvoi dans la  barre de menu pour  ouvrir  la  boîte de dialogue
Champs (Figure 12: Boîte de dialogue Champs – Renvois ).

3. Cliquez sur l’onglet Renvois, puis sélectionnez Texte dans la section Type.

4. Dans la section Sélection, sélectionnez le numéro de formule auquel vous vous référez. 

5. Dans la section Insérer une référence à, sélectionnez Référence et cliquez sur Insérer.

6. Une  fois  la  création  de  renvois  terminée,  cliquez  sur  Fermer pour  fermer  la  boîte  de
dialogue Champs.

Astuce

Pour insérer le numéro du renvoi sans parenthèses, sélectionnez Numérotation au lieu
de Référence dans la section Insérer une référence à.
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Remarque

Si  vous  souhaitez  utiliser  des  crochets  plutôt  que  des  parenthèses,  ou  si  vous
souhaitez que le numéro de renvoi soit séparé de la formule par des tabulations plutôt
que d’utiliser un tableau, référez-vous au chapitre sur les AutoTextes dans le  guide
Writer.

Figure 12: Boîte de dialogue Champs – Renvois 

Ancrage des formules

Une formule est traitée comme un objet au sein de Writer et son ancrage par défaut est  Comme
caractère au  sein  d’un  paragraphe  lorsqu’elle  est  insérée  dans  un  document.  Pour  changer
l’ancrage d’un objet formule :

1. Faites  un clic-droit  sur  l’objet  formule  sélectionné  et  sélectionnez  Ancre dans le  menu
contextuel.

2. Sélectionnez une nouvelle  option  d’ancrage dans le  sous-menu contextuel.  Les  options
d’ancrage  disponibles  sont  À  la  page,  Au  paragraphe,  Au  caractère,  ou  Comme
caractère.
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3. Vous pouvez également faire un clic-droit  sur l’objet formule sélectionné et  sélectionnez
Propriétés dans le menu contextuel, ou allez dans Format > Cadre et objet > Propriétés
dans la barre de menu pour ouvrir la boîte de dialogue Objet (Figure 13 : Boîte de dialogue
Objet – onglet Type avec les options Ancrer).

4. Assurez-vous  que  l’onglet  Type est  sélectionné  et  sélectionnez  une  nouvelle  position
d’ancrage dans la section Ancrer.

5. Cliquez sur OK pour enregistrer vos modifications et fermer la boîte de dialogue Objet.

Remarque

Les options d’ancrage ne sont pas disponibles dans la boîte de dialogue Objet lorsque
vous modifiez les options disponibles pour les styles de cadre. Pour plus d’informations
sur la modification des styles de cadre, référez-vous aux chapitres sur les styles dans le
guide Writer.

Figure 13 : Boîte de dialogue Objet – onglet Type avec les options Ancrer

Alignement vertical

Les paramètres par défaut pour l’alignement vertical des objets formule utilisent la ligne de base du
texte comme référence. Ce paramétrage par défaut  peut  être modifié en changeant le style de
cadre de la formule.  Veuillez consulter les chapitres sur les styles dans le  Guide Writer pour plus
d’informations.
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Pour modifier la position de l’alignement vertical d’un objet formule individuel :

1. Faites un clic-droit sur l’objet formule sélectionné et sélectionnez Propriétés dans le menu
contextuel, ou allez dans  Format > Cadre et objet > Propriétés dans la barre de menu
pour ouvrir la boîte de dialogue  Objet (Figure 13 : Boîte de dialogue Objet – onglet Type
avec les options Ancrer).

2. Assurez-vous  que  l’onglet  Type est  sélectionné  et  sélectionnez  une  nouvelle  position
d’alignement dans la section  Position. Les options d’alignement vertical disponibles  Haut,
Bas, Centre ou Du bas.

3. Si  nécessaire,  tapez  dans  la  boîte  de  texte  une  valeur  inférieure  ou  supérieure  pour
l’alignement vertical. Cette option est uniquement disponible si l’alignement vertical  Du bas
est sélectionné.

4. Sélectionnez le type d’alignement de texte dans la liste déroulante dans la section Position.
Les options d’alignement disponibles sont Ligne de base, Caractère et Ligne.

5. Cliquez sur OK pour enregistrer vos modifications et fermer la boîte de dialogue Objet.

Remarque

Si la section Position dans la boîte de dialogue Objet est grisée et non-disponible, allez
dans  Outils >  Options >  LibreOffice  Writer >  Aides  au  formatage et  décochez
l’option  Alignement de la ligne de base Math. Ce paramètre est sauvegardé avec le
document  et  s’applique  à  toutes  les  formules.  Tout  nouveau  document  utilisera  ce
paramètre pour Alignement de la ligne de base Math.

Espacement d’objet

Lorsqu’il est inséré dans un document Writer, un objet formule a un espacement de chaque côté de
l’objet formule. La valeur par défaut utilisé pour l’espacement est paramétrée au sein du style de
cadre des objets de formule. Elle peut être modifiée en changeant le style de cadre de la formule.
Veuillez consulter les chapitres sur les styles dans le guide Writer pour plus d’informations.

Vous  pouvez  ajuster  individuellement  l’espacement  de  chaque  objet  de  formule  dans  votre
document :

1. Créez votre formule dans le document Writer.

2. Faites un clic-droit sur l’objet formule sélectionné et sélectionnez Propriétés dans le menu
contextuel, ou allez dans  Format > Cadre et objet > Propriétés dans la barre de menu
pour ouvrir la boîte de dialogue Objet.

3. Cliquez sur l’onglet  Adapter pour ouvrir la page  Adapter dans la boîte de dialogue  Objet
(Figure 14 : Boîte de dialogue Objet – onglet Adapter).

4. Dans la section  Espacement, entrez la valeur d’espacement pour  Gauche,  Droit,  Haut et
Bas.

5. Cliquez sur OK pour enregistrer vos modifications et fermer la boîte de dialogue Objet.
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Figure 14 : Boîte de dialogue Objet – onglet Adapter

Remarque

Les options d’adaptation d’objets sont grisées si l’objet est ancré « Comme caractère ».
Pour activer toutes les options d’adaptation, vous devez ancrer l’objet « À la page »,
« Au paragraphe » ou « Au caractère ». Pour changer les paramètres d’ancrage, faites
un clic-droit sur l’objet formule et utilisez le menu contextuel Ancrer pour sélectionner
l’option souhaitée.

Mode texte

Dans les grandes formules  placées dans une ligne de texte,  les éléments de formule peuvent
parfois  être  plus  grands que la  hauteur  du texte.  Ainsi,  pour  rendre les grandes formules  plus
lisibles, il est recommandé de toujours insérer ces formules dans un paragraphe séparé pour qu’elle
soit séparée du texte.

Cependant, s’il est nécessaire de placer une grande formule au sein d’une ligne de texte, double-
cliquez sur la formule pour ouvrir l’Éditeur de formules et allez dans Format > Mode Texte dans la
barre de menu. L’Éditeur de formules rétrécira la formule pour qu’elle s’adapte à la hauteur du texte.
Les numérateurs et dénominateurs des fractions sont rétrécis, et les limites des intégrales et des
sommes sont placées à côté de l’intégrale/du signe de la somme, comme montré dans l’exemple
suivant.
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Exemple
Une formule dans un paragraphe à part : 

∑
i=2

5

i2

et la même formule intégrée dans une ligne de texte en utilisant le format texte : ∑i=2
5 i2

Trame de fond et bordures

La trame de fond (remplissage) et les bordures par défaut des objets de formules mathématiques
sont paramétrées dans le style de cadre des objets de formule. Pour modifier les paramètres de
style de cadre par défaut des objets de formules, veuillez consulter les chapitres sur les styles dans
le  guide  Writer.  Cependant,  il  est  possible de modifier  individuellement la trame de fond et  les
bordures de chaque formule insérée dans le document.

Remarque

La taille du cadre dans lequel une formule est placée lorsqu’elle est insérée dans un
document ne peut pas être modifiée. La taille du cadre d’un objet formule dépend de la
taille  de  police  de  caractères  de  celle-ci,  veuillez  consulter Chapitre  1  Création  et
édition de formules pour plus d’informations.

Trames de fond
1. Dans votre document,  sélectionnez la formule dont vous souhaitez modifier la trame de

fond.

2. Faites un clic droit sur la formule et sélectionnez Propriétés dans le menu contextuel, ou
cliquez sur Formatage > Cadre et objet > Propriétés dans la barre de menu principal pour
ouvrir la boîte de dialogue Objet.

3. Cliquez sur l’onglet  Zone et sélectionnez le type de remplissage désiré  en cliquant sur le
bouton correspondant (Figure 15 : Boîte de dialogue Objet – onglet Zone).

4. Sélectionnez les options désirées pour la trame de fond de votre objet de formule. Les
options diffèrent en fonction du type de remplissage sélectionné.

5. Cliquez sur OK pour enregistrer vos modifications et fermer la boîte de dialogue Objet.
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Figure 15 : Boîte de dialogue Objet – onglet Zone

Bordures
1. Dans votre document, sélectionnez la formule dont vous souhaitez modifier les bordures.

2. Faites un clic droit sur la formule et sélectionnez Propriétés dans le menu contextuel, ou
cliquez sur Formatage > Cadre et objet > Propriétés dans la barre de menu principal pour
ouvrir la boîte de dialogue Objet.

3. Cliquez sur l’onglet  Bordures et  sélectionnez les options désirées pour les bordures de
votre formule (Figure 16 : Boîte de dialogue Objet – onglet Bordures).

4. Cliquez sur OK pour enregistrer vos modifications et fermer la boîte de dialogue Objet.

Exemple
Voici,  ci-dessous, un exemple de formule qui utilise une couleur de trame de fond et des
bordures.

 ∑
i=1

n

wi y i  

Veuillez noter que les propriétés de couleur de trame de fond et de bordures dépendent de
l’objet OLE de Math et ne peuvent donc pas être définis par des balises dans le code de la
formule.
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Figure 16 : Boîte de dialogue Objet – onglet Bordures

Insertion rapide de formules mathématiques

Pour insérer rapidement une formule dans votre document Writer sans ouvrir l’éditeur de formules,
si vous connaissez le balisage de la formule :

1. Entrez le balisage de la formule dans le document à l’endroit où vous souhaitez insérer la
formule.

2. Sélectionnez le balisage.

3. Cliquez sur  Insertion > Objet dans la barre de menu principal et sélectionnez  Formule
pour créer une formule à partir du balisage sélectionné.

4.
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Chapitre 3 
Les formules dans Calc, Draw et
Impress
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Introduction

Dans Calc, Draw et Impress, les formules mathématiques sont insérées en tant qu’objets OLE, sans
aucune trame de fond (remplissage)  ou bordures.  Veuillez  consulter  le Chapitre  1  Création  et
édition de formules pour plus d’informations sur l’insertion des formules dans un module LibreOffice.
Chaque objet de type « formule » peut être inséré dans un tableur, un dessin ou une diapositive de
la manière suivante :

• Dans Calc, les formules sont insérées dans une cellule sans aucun style assigné à l’objet
formule.

• Dans Draw et Impress, les formules sont insérées au centre de votre dessin ou de votre
diapositive et le style Objet sans remplissage et sans ligne leur est attribué par défaut. Pour
plus d’information sur comment modifier ou assigner des styles d’objets dessins,  veuillez
consulter le Guide Draw ou le Guide Impress.

Ancrage des formules

Calc
Un  objet  formule  peut  être  ancré  dans  un  tableur  soit  À la page (par  défaut),  À la cellule
(redimensionner avec la cellule) ou  À la cellule. Pour changer le type d’ancrage d’une formule
dans un tableur Calc :

1. Sélectionnez l’objet formule dans votre tableur.

2. Faites un clic droit sur la formule et sélectionnez dans le menu contextuel  Ancrer puis le
type d’ancrage souhaité.

3. Vous pouvez aussi  aller  dans  Formatage > Ancrer dans la  barre de menu principal  et
sélectionner le type d’ancrage souhaité.

Astuce

Si une formule insérée dans un tableur Calc ne semble pas être à la bonne échelle, il
est  possible  de  la  recadrer  en  faisant  un  clic  droit  sur  l’objet  formule,  puis  en
sélectionnant Taille originale dans le menu contextuel.

Draw et Impress
Lorsqu’une  formule  est  insérée  dans  un  dessin  ou  un  diaporama,  elle  est  insérée  en  tant
qu’objet OLE flottant qui ne sera pas ancré à une position définie dans le dessin/le diaporama.

Propriétés des objets formules

Dans Calc, Draw et Impress, les objets de formules peuvent être modifiés tout comme n’importe
quel autre objet placé dans un tableur, un dessin ou une présentation, à l’exception de la taille de
l’objet formule et du format du texte d’une formule. Pour plus d’informations sur la modification des
propriétés d’un objet, veuillez consulter le Guide Calc, le Guide Draw et le Guide Impress. Pour plus
d’information sur la taille des objets formules et sur le formatage du texte d’une formule, référez-
vous au Chapitre 1 Création et édition de formules de ce guide.

Les instructions suivantes vous permettent de sélectionner la  section de la palette  Propriétés du
volet latéral à utiliser si vous souhaitez changer les propriétés des objets formules.

• Pour les trames de fond de formules, utilisez les diverses options de la section Zone.
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• Pour les bordures de formules, utilisez les diverses options dans la section Ligne. Veuillez
noter  que  les  bordures  de  formules  sont  différentes  des  bordures  de  cellules  d’un
tableur Calc.

• Pour repositionner un objet formule de manière précise, utilisez les diverses options de la
section Position et Taille.

• Dans Draw et Impress, vous pouvez arranger, aligner, regrouper, retourner, convertir, diviser,
combiner et modifier les points des objets formules.

• Vous ne pouvez pas changer les attributs textes d’un objet formule. Le texte utilisé dans une
formule est fixé lorsque vous créez une formule dans l’Éditeur de formules.

• La taille d’un objet formule est fixée par la taille de la police utilisée pour la formule lorsque
celle-ci est créée dans l’Éditeur de formules. La taille de l’objet formule est automatiquement
verrouillée. L’option se trouve dans la boîte de dialogue Position et Taille (accessible par le
menu  Format > Objet > Postion et taille)  et  peut être désactivée si  vous le souhaitez.
Cette méthode n’est cependant pas conseillée, car redimensionner un objet formule à l’aide
de la fenêtre Position et Taille risque de déformer la formule et la rendre difficile à lire.

Insertion de formules dans les graphiques

Un graphique inséré dans un tableur Calc est un objet OLE en lui-même, il est ainsi impossible
d’utiliser l’éditeur de formules pour créer et insérer une formule directement dans un graphique.
Toutefois,  il  est  possible de créer  les objets  Graphique et  Math séparément et  de copier-coller
ensuite la formule mathématique dans l’objet Graphique :

1. Créez le  graphique  dans  LibreOffice Calc.  Pour  plus  d’informations  sur  la  création  de
graphiques dans Calc, consultez le Guide Calc.

2. Cliquez sur n’importe quelle cellule du tableur pour désélectionner le graphique.

3. Insérez un objet formule Math en sélectionnant le menu Insertion > Objet > Formule.

4. Entrez la formule désirée dans l’éditeur de formule.

5. Après avoir entré la formule, sélectionnez l’objet formule Math et appuyez sur Ctrl+C pour
copier l’objet de formule dans le presse-papiers.

6. Double-cliquez sur le graphique pour le modifier et appuyez sur  Ctrl+V pour coller l’objet
formule dans le graphique.

7. Vous pouvez maintenant positionner l’objet formule n’importe où sur le graphique.

La  Figure  17 :  Graphique  Calc  avec  un  objet  formule  Math  inséré montre  un  exemple  d’un
graphique Calc avec un objet formule Math à l’intérieur, dans cet exemple la fonction sin (x ).
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Si vous désirez changer la formule plus tard, vous devez répéter le processus entier de création,
copie et collage de l’objet formule dans le graphique.

Formules chimiques

Math  sert principalement à créer des formules mathématiques, mais peut aussi être utilisé pour
écrire  des  formules  chimiques.  Cependant,  les  symboles  des  formules  chimiques  sont
généralement écrits en lettres majuscules non italiques. Le tableau ci-dessous montre quelques
exemples de formules chimiques.

Construction Exemple Balisage

Molécules H2SO4
H_2 SO_4

Isotopes U92
238 U lsub 92 lsup 238

Ions SO4
2−ou SO4

2- SO_4^{2-{}} ou SO_4^{2"-"}

Pour créer des formules chimiques avec Math, vous devez modifier la police de caractères des
variables en une police non italique. Pour plus d’informations sur comment modifier les polices de
caractères dans une formule, veuillez consulter le Chapitre 1 Création et édition de formules.

Il  n’existe  pas  de  symbole  de  flèche  double  dans  Math,  permettant  d’illustrer  les  réactions
réversibles dans une formule chimique. Si une police de caractères tierce proposant les symboles
manquants est  installée sur votre ordinateur,  vous pouvez ajouter  ces symboles au  Catalogue.
Veuillez  consulter « Personnalisation  du Catalogue » à  la  page 56 pour  plus  d’informations  sur
l’ajout de symboles au Catalogue.
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Introduction

Ce chapitre explique comment LibreOffice Math peut être personnalisé et adapté à votre manière
de créer des formules mathématiques pouvant être ajoutées à des documents LibreOffice. Vous
pouvez aussi consulter le Guide du débutant pour des informations à propos de la personnalisation
de LibreOffice.

Fenêtres flottantes

L’Éditeur de formules et le volet Éléments peuvent couvrir une grande partie de l’espace de travail.
Il est possible de transformer l’Éditeur de formules et le volet Éléments en fenêtres flottantes afin de
libérer de l’espace et/ou de les déplacer sur votre espace de travail.

1. Placez le curseur de la souris sur la zone grise en bordure de fenêtre.

2. Maintenez la  touche  Ctrl enfoncée et  double-cliquez.  L’Éditeur de formules deviendra la
fenêtre Commandes (Figure 18 : Fenêtre Commandes) et le  volet Éléments deviendra la
fenêtre Éléments (Figure 19 : Fenêtre Éléments).

Figure 18 : Fenêtre Commandes

Figure 19 : Fenêtre Éléments

Pour rendre aux fenêtres Commandes et Éléments leur apparence d’origine :

3. Placez le curseur sur la bordure grise de la fenêtre (PAS la barre-titre en haut de la boîte de
dialogue).

4. Maintenez la touche Ctrl enfoncée et double-cliquez.
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Ajout de raccourcis clavier

Vous pouvez ajouter des raccourcis clavier afin d’adapter la création de documents à votre flux de
travail et ainsi utiliser LibreOffice plus rapidement et intuitivement. Ci-dessous un exemple d’ajout
de raccourci clavier pour insérer une formule Math dans un document LibreOffice.

Remarque

Lorsque vous créez de nouveaux raccourcis clavier, veillez à ne pas sélectionner un
raccourci  déjà  utilisé  dans  LibreOffice  ou  sur  votre  ordinateur.  Par  exemple,  la
combinaison de touches  Maj+Ctrl+F2 dans Calc déplace le curseur vers la ligne de
saisie où vous pouvez insérer une formule Calc dans la cellule sélectionnée, et  NON
dans une formule Math.

Exemple d’ajout de raccourci
1. Allez dans  Outils > Personnaliser sur la barre de menu principal pour ouvrir  la fenêtre

Personnaliser (Figure 20 : Fenêtre Personnaliser – onglet Clavier).

2. Cliquez  sur  l’onglet  Clavier pour  accéder  aux  options  disponibles  pour  ajouter  des
raccourcis clavier.

Figure 20 : Fenêtre Personnaliser – onglet Clavier

3. Sélectionnez le niveau du nouveau raccourci clavier.

– Sélectionnez  LibreOffice  si vous désirez que le nouveau raccourci clavier soit pris en
compte dans tous les modules LibreOffice.

– Sélectionnez Math si vous désirez que le nouveau raccourci clavier soit uniquement pris
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en compte dans LibreOffice Math.
4. Dans la liste Catégorie, sélectionnez Insérer.

5. Dans la liste Fonction, sélectionnez la seconde entrée Formule.

6. Dans la liste Raccourcis clavier, sélectionnez la touche ou la combinaison de touches que
vous souhaitez utiliser pour ce nouveau raccourci.

7. Cliquez sur Modifier. Votre raccourci clavier apparaîtra dans la liste Touches.

8. Vous pouvez ajouter autant de raccourcis clavier que nécessaire en répétant les étapes ci-
dessus.

Cliquez sur OK pour sauvegarder vos raccourcis clavier et fermer la fenêtre Personnaliser.

Attention

Il existe deux commandes « Formules » différentes dans la fenêtre Personnaliser de
Writer ;  bien  qu’elles  aient  le  même nom,  elles  correspondent  à  deux  commandes
LibreOffice différentes. Comme illustré dans la  Figure 21 : Attribuer un raccourci pour
l’insertion de nouveaux objets Math, la première commande « Formule » sert à insérer
des champs calculés dans Writer tandis que la seconde commande « Formule » sert à
insérer de nouveaux objets Math.

Figure 21 : Attribuer un raccourci pour l’insertion de nouveaux objets Math

Options de personnalisation de clavier
Les options pour personnaliser les raccourcis clavier sont :

• LibreOffice – affiche les raccourcis clavier communs à tous les modules LibreOffice.

• Math,  Writer,  Calc,  Draw,  ou  Impress –  affiche  les  raccourcis  clavier  pour  le  module
LibreOffice actif.

• Raccourcis  clavier –  liste  les  différents  raccourcis  et  les  commandes  qui  leur  sont
associées. Pour attribuer ou modifier le raccourci clavier pour la commande sélectionnée
dans la liste Fonction, créez un raccourci dans cette liste puis cliquez sur Modifier.

• Fonctions – tapez le nom de la fonction désirée dans le champ de texte pour la rechercher
dans la liste Fonction.

• Fonction –  liste  les  catégories  de  fonctions  et  les  fonctions  LibreOffice  auxquelles  des
raccourcis clavier peuvent être attribués.

– Catégorie – liste les catégories de fonction disponibles.
– Fonction – liste les fonctions de la catégorie. Si la fonction sélectionnée possède déjà un

raccourci clavier, elle sera affichée dans la liste Touches.
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– Touches – affiche les touches de raccourci associées à la fonction sélectionnée.
• Modifier – attribue la combinaison de touches sélectionnée dans la liste Raccourcis clavier

à la commande sélectionnée dans la liste Fonction.

• Supprimer –  supprime  l’élément  ou  les  éléments  sélectionné(s)  sans  demande  de
confirmation.

• Charger –  remplace  la  configuration  de  touches  de  raccourci  par celle  sauvegardée
précédemment.

• Enregistrer – sauvegarde la configuration de touches actuelle pour pouvoir la charger plus
tard.

• Rétablir – restaure les valeurs par défaut, effaçant ainsi les valeurs modifiées.

Personnalisation du Catalogue

Si vous utilisez régulièrement un symbole qui n’est pas disponible dans Math, vous pouvez l’ajouter
à la fenêtre Symboles (Figure 22 : Boîte de dialogue Symboles) en ouvrant l’Éditeur de symboles
(Figure 23 : Boîte de dialogue Éditer les symboles).

En utilisant l’Éditeur de symboles, vous pouvez ajouter des symboles à un jeu de symboles, éditer
les  jeux  de  symboles  ou  modifier  les  notations  des  symboles.  Vous  pouvez  aussi  définir  de
nouveaux jeux de symboles, nommer les symboles ou modifier des jeux de symboles existants.

Ajout de symboles
1. Sélectionnez Outils > Symboles dans la barre de menu principal ou cliquez sur l’icône

Symboles  dans la barre d’outils pour ouvrir la fenêtre Symboles.

2. Cliquez sur le bouton Éditer pour ouvrir la fenêtre Éditer les symboles.

3. Sélectionnez une police de caractère depuis la liste déroulante Police.

4. Sélectionnez le  symbole que vous souhaitez insérer à partir  de la  zone d’aperçu.  Vous
pouvez naviguer dans la liste de symboles en défilant vers le bas ou vers le haut pour
trouver le symbole que vous cherchez. La zone d’aperçu en bas à droite affiche le symbole
sélectionné.

5. Dans le champ Symboles, entrez un nom facilement reconnaissable pour le symbole que
vous ajoutez.

6. Dans  le champ Jeu de symboles, sélectionnez un jeu de symboles de la liste déroulante
dans lequel vous souhaitez ajouter le nouveau symbole, ou entrez un nouveau nom pour
créer un nouveau jeu de symboles pour le nouveau symbole.

7. Si besoin, sélectionnez un style de police à partir de la liste déroulante  Style – Standard,
Italique, Gras ou Gras italique.

8. Cliquez sur  Ajouter, puis cliquez sur  OK pour fermer la fenêtre  Éditer les symboles. Le
nouveau symbole ainsi que le nouveau jeu de symboles (si vous en avez créé un) peuvent
désormais être utilisés.
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Figure 22 : Boîte de dialogue Symboles

Figure 23 : Boîte de dialogue Éditer les symboles

Remarques

Lorsqu’un  nouveau  symbole  est  ajouté  au  catalogue,  vous  pouvez  taper  un  signe
pour cent (%) suivi du nom du symbole dans le balisage de l’Éditeur de formules pour
insérer ce symbole dans la formule. Rappelez-vous que les noms de symboles sont
sensibles  à  la  casse.  Par  exemple :  %prime insérera  un  symbole  complètement
différent de %Prime.
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Si vous ne trouvez pas un symbole dans les polices de caractères installées sur votre
ordinateur,  sachez que de nombreuses polices gratuites et possédant ces symboles
sont disponibles en ligne. Par exemple, la police STIX a été développée spécialement
pour l’écriture de textes mathématiques et techniques. Les polices DejaVu et Lucida
offrent aussi un large choix de symboles.

Lorsque vous installez LibreOffice sur votre ordinateur, seuls les symboles définis par
l'utilisateur qui apparaissent réellement dans le document sont stockés avec celui-ci.
Parfois,  il  est  utile  d’intégrer  tous  les  symboles  définis  par  l’utilisateur  pour  que  le
document, s’il est transféré vers un autre ordinateur, puisse être modifié par une autre
personne. Allez dans Outils > Options > LibreOffice Math > Paramètres et décochez
l’option  Incorporer uniquement les symboles utilisés (taille de fichier inférieure). Cette
option n’est disponible qu’avec LibreOffice Math.

Édition de symboles

Changer les noms de symboles
Dans la boîte de dialogue Éditer les symboles, vous pouvez changer le nom d’un symbole comme
suit :

1. Sélectionnez  le  nom du  symbole  que  vous  souhaitez  changer  dans  la  liste  déroulante
Ancien symbole. Le symbole apparaît dans le panneau d’aperçu en bas à gauche de la
fenêtre Éditer les symboles (Figure 23 : Boîte de dialogue Éditer les symboles).

2. Entrez  un nouveau  nom pour  le  symbole  dans le  champ  Symbole,  ou  sélectionnez  un
nouveau nom à partir de la liste déroulante Symbole. Le nouveau nom du symbole apparaît
au-dessus du panneau d’aperçu en bas à droite de la fenêtre Éditer les symboles.

3. Cliquez sur Modifier pour confirmer le changement de nom du symbole.

4. Cliquez sur OK pour fermer la fenêtre Éditer les symboles.

Déplacer les symboles
Vous pouvez déplacer un symbole d’un jeu de symboles vers un autre comme suit :

1. Dans la liste déroulante  Ancien jeu de symboles, sélectionnez le jeu de symboles où se
trouve le symbole que vous souhaitez déplacer.

2. Sélectionnez le nom du symbole que vous souhaitez déplacer à partir de la liste déroulante
Ancien symbole.  Le symbole apparaît  sur  le  panneau d’aperçu en bas à gauche de la
fenêtre  Éditer les symboles (Figure 23 : Boîte de dialogue Éditer les symboles)

3. Dans la liste déroulante Jeu de symboles, sélectionnez le jeu de symboles dans lequel vous
souhaitez  déplacer  le  symbole.  Le  nom  du  jeu  de  symboles  sélectionné  apparaît  en
dessous du panneau d’aperçu en bas à droite de la fenêtre Éditer les symboles.

4. Cliquez sur Modifier pour déplacer le symbole vers le jeu de symboles sélectionné.

5. Cliquez sur OK pour fermer la fenêtre Éditer les symboles.

Supprimer des symboles
Vous pouvez supprimer un symbole d’un jeu de symboles comme suit :

1. Dans la liste déroulante  Ancien jeu de symboles,  sélectionnez le jeu de symboles dans
lequel le symbole que vous souhaitez supprimer se trouve.

2. Sélectionnez le nom du symbole que vous souhaitez supprimer dans la liste déroulante
Ancien symbole.  Le symbole apparaît  sur  le  panneau d’aperçu en bas à gauche de la
fenêtre  Éditer les symboles (Figure 22 : Boîte de dialogue Symboles)

3. Cliquez sur Supprimer pour supprimer le symbole du jeu de symboles sans confirmation.
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4. Cliquez sur OK pour fermer la fenêtre Éditer les symboles.

Remarque

Il n’est possible de supprimer un jeu de symboles qu’en supprimant tous les symboles
de celui-ci. Le jeu de symbole sera automatiquement supprimé après la suppression du
dernier symbole de celui-ci.

Options d’édition de symboles
• Ancien symbole – sélectionnez le nom du symbole actuellement utilisé.  Le symbole,  le

nom du  symbole  et  le  jeu  de  symboles  dans  lequel  il  se  trouve  sont  affichés  dans  le
panneau d’aperçu en bas à gauche de la fenêtre Éditer les symboles.

• Ancien  jeu  de  symbole –  cette  liste  déroulante  contient  le  nom  du  jeu  de  symbole
actuellement utilisé. Vous pouvez aussi sélectionner un autre jeu de symbole à partir de
cette liste.

• Symbole –  liste  les  noms  des  symboles  dans  le  jeu  de  symbole  actuellement  utilisé.
Sélectionnez un nom dans la liste ou tapez un nouveau nom.

• Jeu de symboles – cette liste déroulante contient les noms de tous les jeux de symboles
existants. Vous pouvez modifier un jeu de symbole ou en créer un nouveau.

• Police – affiche le nom de la police de caractères actuelle et permet de sélectionner une
police différente.

• Sous-ensemble – si vous sélectionnez une police sans symbole, vous pouvez sélectionner
un sous-ensemble Unicode dans lequel vous pouvez placer votre nouveau symbole ou votre
symbole édité. Lorsqu’un sous-ensemble est sélectionné, tous les symboles appartenant à
l’ensemble du jeu de symbole actuellement utilisé sont affichés dans la liste Symbole.

• Style – le style de police de caractères actuellement utilisé. Vous pouvez changer le style de
la police de caractères à partir de la liste déroulante.

• Ajouter – cliquez sur ce bouton pour ajouter le symbole (affiché sur la fenêtre d’aperçu à
droite) au jeu de symboles actuellement utilisé. Le symbole sera sauvegardé sous le nom
affiché  dans  la  liste  Symbole.  Vous  devez  spécifier  un  nom sous  Symbole ou  Jeu  de
symboles pour déverrouiller le bouton Ajouter. Un même nom ne peut pas être utilisé plus
d’une fois.

• Modifier – cliquez sur ce bouton pour remplacer le nom du symbole affiché dans la fenêtre
d’aperçu  à  gauche  (le  nom  précédent  est  affiché  sur  la  liste  Ancien  symbole)  avec  le
nouveau nom que vous avez entré dans la liste Symbole.

• Supprimer –  cliquez  sur  ce  bouton  pour  supprimer  le  symbole  affiché  dans  la  fenêtre
d’aperçu à gauche du jeu de symboles actuellement utilisé.   La suppression du dernier
symbole restant d’un jeu de symboles supprimera par la suite ce même jeu de symboles.

• Annuler –  à n’importe quel  moment,  vous pouvez cliquer  sur  ce bouton pour  fermer  la
fenêtre. Les modifications ne seront pas sauvegardées.

Espacement dans la formule

Un accent grave (`) sert à insérer un petit espace supplémentaire dans une formule tandis qu’un
tilde  (~)  sert  à  insérer  un  espace  supplémentaire.  Cependant,  dans  l’installation  de  base  de
LibreOffice, ces symboles sont ignorés lorsqu’ils sont placés à la fin d’une formule. Si vous travaillez
avec un texte courant, il peut être nécessaire d’inclure un espacement à la fin d’une formule. Ce
paramètre n’est nécessaire que lorsque vous travaillez sur un document Math. Il n’est pas requis
pour l’insertion de formules dans tout autre module LibreOffice.
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Pour  ajouter  une  espace  à  la  fin  d’une  formule  dans  Math,  allez  dans  Outils >  Options >
LibreOffice Math > Paramètres dans la barre de menu principal et décochez Ignorer ~ et ` en fin
de ligne dans la section Autres options.

Remarque

Pour  personnaliser  les  paramètres  LibreOffice Math,  vous  devez  d’abord  démarrer
l’application puis naviguer vers Outils > Options > LibreOffice Math > Paramétrages.
Lisez Création  d’une  formule  en  tant  que  document  séparé page  10, pour  plus
d’informations sur le lancement de LibreOffice Math.

Extensions
Si vous créez des formules dans vos documents de manière fréquente, vous pouvez personnaliser
LibreOffice en ajoutant des extensions conçues pour vous aider dans la création de formules. Les
extensions  peuvent  être  installées  facilement  avec  le  Gestionnaire  d’extensions.  Pour  plus
d’informations sur l’installation d’extensions, consultez le Guide du débutant.

Une des extensions les plus utilisées se nomme Formater toutes les formules mathématiques.
Avec  cette  extension,  vous  pouvez  formater  toutes  vos  formules  mathématiques  pour  vos
documents Writer, Calc, Draw et Impress. Vous pourrez ainsi modifier les noms et tailles de police
de  caractères  de  toutes  les  formules  présentes  dans  le  document.  Pour  plus  de  détails  sur
l’extension, cliquez sur le lien suivant : https://extensions.libreoffice.org/extensions/formatting-of-all-
math-formulas.

60 | Guide LibreOffice Math Version 7.0

https://extensions.libreoffice.org/extensions/formatting-of-all-math-formulas
https://extensions.libreoffice.org/extensions/formatting-of-all-math-formulas


Guide Math

Chapitre 5 
Exporter et Importer



Exporter au format MathML

Outre l’exportation de documents au format PDF, tel  que présenté dans le  Guide  du débutant,
LibreOffice offre également la possibilité d’exporter des formules au format MathML. Ainsi,  vous
pouvez insérer  des  formules  dans des documents créés à  partir  de  logiciels  externes,  comme
Microsoft Office ou un navigateur internet.

Remarque

Certains navigateurs internet ne supportent pas les fichiers au format MathML ; votre
formule pourrait ne pas s’afficher correctement.

Si  vous  travaillez  sur  un  document  Math,  dans  la  barre  de  menu,  sélectionnez  Fichier >
Enregistrer  sous,  ou  utilisez  le  raccourci  clavier  Ctrl+Maj+S pour  ouvrir  la  boîte  de  dialogue
Enregistrer sous. Pour enregistrer votre formule au format MathML, sélectionnez MathML dans la
liste Type de fichiers qui s’affiche.

Si vous travaillez sur un autre module LibreOffice,faites un clic droit sur la formule et sélectionnez
dans le menu contextuel  Enregistrer la copie sous pour ouvrir la boîte de dialogue  Enregistrer
sous. Pour enregistrer votre formule au format MathML, sélectionnez MathML dans la liste Type des
objets qui s’affiche.

Avec le module Math, vous pouvez également importer des formules au format MathML. Pour ce
faire, dans le menu principal, cliquez sur Outils > Importer MathML depuis le presse-papiers.

Formats de fichiers Microsoft

LibreOffice vous permet  de définir  les méthodes d’importation et  d’exportation des formules au
format  Microsoft : dans  la  barre  de  menu  principale,  sélectionnez  Outils >  Options >
Chargement/Enregistrement >  Microsoft  Office, puis  cochez  ou  décochez  les  options  de
conversion des fichiers, de MathType à LibreOffice Math ou inversement.

• [L]  : Charger et convertir l’objet

• [S]  : Convertir et enregistrer l’objet

[L] : Charger et convertir l’objet
Choisissez cette option si vous voulez convertir les objets Microsoft OLE en objets LibreOffice OLE,
lorsqu’un document Microsoft est ouvert dans le logiciel. Pour réussir à charger et à convertir vos
formules,  tous  les  objets  MathType  ne  doivent  pas  dépasser  les  spécifications  du  module
MathType 3.1.  Des  informations  sur  le  format  MathType  sont  disponibles  sur  le  site
http://www.dessci.com/en.

Si un document contenant des équations au format OMML a été enregistré au format .docx, puis
converti à l’ancien format .doc, tous les objets OMML sont convertis en graphiques qui s’afficheront
dans LibreOffice.

[S] : Convertir et enregistrer l’objet
Choisissez cette option si  vous souhaitez convertir  et  enregistrer les objets LibreOffice OLE au
format de fichiers Microsoft. Avec LibreOffice, vous pouvez convertir tous types de formules en un
format qui peut être lu ou modifié sur MathType et sur l’éditeur de formules de Microsoft.

Lorsque  cette  option  n’est  pas  cochée,  la  formule  est  traitée  comme un  objet  OLE lors  de la
conversion au format .doc, et reste liée à LibreOffice. En double-cliquant sur l’objet, il cherchera à
s’ouvrir sur LibreOffice.
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Introduction

La  présente  annexe  répertorie  les  opérateurs  et  les  commandes  disponibles  dans  l’éditeur  de
formules, que vous pouvez utiliser pour écrire vos formules.

Pour  insérer  les  opérateurs  et  les  commandes  les  plus  utilisés,  cliquez  sur  le  symbole
correspondant dans le panneau Éléments. Si les tableaux suivants ne contiennent pas le symbole
que  vous  recherchez,  vous devez utiliser  un langage de balisage  pour  saisir  l’opérateur  ou  la
commande recherchée dans l’éditeur de formules.

Remarque

Dans le langage de balisage indiqué dans les tableaux suivants, vous devez remplacer
le paramètre fictif <?> par la valeur que vous souhaitez insérer dans vos formules.

Commandes d’opérateurs unaires/binaires

Pour accéder aux symboles utilisés pour saisir le langage de balisage des commandes d’opérateurs
unaires/binaires dans l’éditeur de formules, sélectionnez  Opérateurs unaires/binaires dans la liste
déroulante, en haut du panneau Éléments.

Opération Langage de balisage Exemple de formule

Plus + +1

Moins - −1

Plus/moins +- ou plusminus ±1

Moins/plus -+ ou minusplus ∓1

Addition <?> + <?> A+B

Soustraction <?> - <?> A−B

Multiplication (Point) <?> cdot <?> A⋅B

Multiplication <?> times <?> A×B

Multiplication (*) <?> * <?> A∗B

Division (en fraction) {<?>} over {<?>}
A
B

Division <?> div <?> A÷B

Division (avec petite barre) <?> / <?> ou <?> slash <?> A /B

Division (avec grande barre) {<?>} wideslash {<?>}
A
B
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Division (avec barre 
inversée)

<?> widebslash <?>
A
B

Concaténation <?> circ <?> A∘B

NON booléen neg <?> ¬A

ET booléen <?> and <?> ou <?> & <?> A∧B

OU booléen <?> or <?> A∨B

Barre inversée <?> bslash <?> A∖B

Barre encerclée <?> odivide <?> A⊘B

Petit symbole de 
multiplication encerclé

<?> odot <?> A⊙B

Symbole de soustraction 
encerclé

<?> ominus <?> A⊖B

Symbole d’addition encerclé <?> oplus <?> A⊕B

Symbole de multiplication 
encerclé

<?> otimes <?> A⊗B

Opérateur binaire défini par 
l’utilisateur (binOp dans 
l’exemple)

<?> boper ????? <?> A binOp B

Opérateur unaire défini par 
l’utilisateur (unOp dans 
l’exemple)

uoper ????? <?> unOp B

Commandes - Relations

Pour accéder aux symboles utilisés pour saisir le langage de balisage des commandes de relations
dans l’éditeur de formules, sélectionnez  Relations dans la liste déroulante  en haut du panneau
Éléments.

Opération Langage de balisage Exemple de formule

Est égal à <?> = <?> A=B

Est différent de <?> <> <?> ou <?> neq <?> A≠B

Est inférieur à <?> < <?> ou <?> lt <?> A<B

Est inférieur ou égal à <?> <= <?> A≤B
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Est inférieur ou égal à <?> leslant <?> A⩽B

Est supérieur à <?> > <?> ou <?> gt <?> A>B

Est supérieur ou égal à <?> >= <?> A≥B

Est supérieur ou égal à <?> geslant <?> A⩾B

Est nettement inférieur à <?> << <?> ou <?> ll <?> A≪B

Est très supérieur à <?> >> <?> ou <?> gg <?> A≫B

Est approximativement égal à <?> approx <?> A≈B

Est similaire à <?> sim <?> A∼B

Est similaire ou égal à <?> simeq <?> A≃B

Est identique à <?> equiv <?> A≡B

Est proportionnel à <?> prop <?> A∝B

Est parallèle à <?> parallel <?> A∥B

Est perpendiculaire à <?> ortho <?> A⊥B

Divise <?> divides <?> A∣B

Ne divise pas <?> ndivides <?> A∤B

Tend vers <?> toward <?> A→B

Double flèche vers la gauche <?> dlarrow <?> A⇐B

Double flèche bilatérale <?> dlrarrow <?> A⇔B

Double flèche vers la droite <?> drarrow <?> A⇒B

Précède <?> prec <?> A≺B

Suit <?> succ <?> A≻B

Précède ou égale <?> preccurlyeq <?> A≼B

Suit ou égale <?> succcurlyeq <?> A≽B

Précède ou équivaut à <?> precsim <?> A≾B
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Suit ou équivaut à <?> succsim <?> A≿B

Ne précède pas <?> nprec <?> A⊀B

Ne suit pas <?> nsucc <?> A⊁B

Définition <?> def <?> A≝B

Correspondance image de <?> transl <?> A⊷B

Correspondance originale de <?> transr <?> A⊶B

Commandes Opérations d’ensemble

Pour accéder aux symboles utilisés pour saisir le langage de balisage des commandes d’opérations
d’ensemble dans l’éditeur de formules, choisissez Opérateurs d’ensemble dans la liste déroulante
en haut du panneau Éléments.

Opération Langage de balisage Exemple de formule

Appartient <?> in <?> A∈B

N’appartient pas <?> notin <?> A∉B

Contient <?> owns <?> ou<?> ni <?> A∋B

Intersection <?> intersection <?> A∩B

Union <?> union <?> A∪B

Différence
<?> setminus <?> ou
<?> bslash <?> A∖B

Ensemble quotient (barre 
oblique) entre les caractères

<?> slash <?> A /B

Sous-ensemble <?> subset <?> A⊂B

Sous-ensemble ou égal à <?> subseteq <?> A⊆B

Sur-ensemble <?> supset <?> A⊃B

Sur-ensemble ou égal à <?> supseteq <?> A⊇B

Pas sous-ensemble <?> nsubset <?> A⊄B

Pas sous-ensemble ou égal à <?> nsubseteq <?> A⊈B
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Pas sur-ensemble <?> nsupset <?> A⊅B

Pas sur-ensemble ou égal à <?> nsupseteq <?> A⊉B

Ensemble vide emptyset ∅

Aleph (nombres cardinaux) aleph ℵ

Ensemble des entiers naturels setN ℕ

Ensemble des entiers setZ ℤ

Ensemble des rationnels setQ ℚ

Ensemble des réels setR ℝ

Ensemble des complexes setC ℂ

Fonctions

Pour accéder aux symboles utilisés pour saisir le langage de balisage des commandes de fonctions
d’ensemble dans l’éditeur de formules, choisissez  Fonctions dans la liste déroulante  en haut du
panneau Éléments.

Opération Langage de balisage Exemple de formule

Valeur absolue abs{<?>} |A|

Factoriel fact{<?>} A!

Racine carrée sqrt{<?>} √ A

Racine nième nroot{<?>}{<?>} A
√B

Puissance <?>^{<?>} AB

Exponentiel naturel func e^{<?>} eA

Logarithme naturel ln(<?>) ln (A)

Fonction exponentielle exp(<?>) exp (A )

Logarithme log(<?>) log ( A)

Sinus sin(<?>) sin (A )

Cosinus cos(<?>) cos (A )
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Tangente tan(<?>) tan (A )

Cotangente cot(<?>) cot (A )

sinus hyperbolique sinh(<?>) sinh (A )

Cosinus hyperbolique cosh(<?>) cosh (A )

Tangente hyperbolique tanh(<?>) tanh (A)

Cotangente hyperbolique coth(<?>) coth (A )

Sinus ou arc sinus inversé arcsin(<?>) arcsin (A )

Cosinus ou arc cosinus 
inversé

arccos(<?>) arccos (A )

Tangente ou arc tangente 
inversé

arctan(<?>) arctan (A )

Cotangente ou arc 
cotangente inversé

arccot(<?>) arccot (A )

Argument sinus 
hyperbolique

arsinh(<?>) arsinh (A )

Argument cosinus 
hyperbolique

arcosh(<?>) arcosh (A )

Argument tangente 
hyperbolique

artanh(<?>) artanh (A)

Argument cotangente 
hyperbolique

arcoth(<?>) arcoth (A )

Epsilon inversé backepsilon ∍

Indice <?> sub <?> ou <?> _ <?> AB

Opérateurs

Pour accéder aux symboles utilisés pour saisir le langage de balisage des commandes d’opérateurs
dans l’éditeur de formules, choisissez  Opérateurs dans la liste déroulante  en haut du panneau
Éléments.

Opération Langage de balisage Exemple de formule

Limites lim <?> lim A
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Borne inférieure lim from{<?>} <?> lim
A
B

Borne supérieure lim to{<?>} <?> lim
A

B

Bornes inférieure et 
supérieure 

lim from{<?>} to{<?>} <?> lim
A

B

C

Limite inférieure liminf <?> lim inf A

Limite supérieure limsup <?> lim sup A

Somme sum <?> ∑a

Borne inférieure de la 
somme

sum from{<?>} <?> ∑
A

B

Borne supérieure de la 
somme

sum to{<?>} <?> ∑
A

B

Bornes inférieure et 
supérieure de la somme

sum from{<?>} to{<?>} <?> ∑
A

B

C

Produit prod <?> ∏ A

Borne inférieure du produit prod from{<?>} <?> ∏
A

B

Borne supérieure du produit prod to{<?>} <?> ∏
A

B

Bornes inférieure et 
supérieure du produit

prod from{<?>} to{<?>} <?> ∏
A

B

C

Coproduit coprod <?> ∐ A

Borne inférieure du 
coproduit

coprod from{<?>} <?> ∐
A

B

Borne supérieure du 
coproduit

coprod to{<?>} <?> ∐
A

B

Bornes inférieure et 
supérieure du coproduit

coprod from{<?>} to{<?>} 
<?> ∐

A

B

C

Intégrale int <?> ∫dA
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Borne inférieure de 
l’intégrale

int from{<?>} <?> ∫
A

dB

Borne supérieure de 
l’intégrale

int to{<?>} <?> ∫
A

dB

Bornes inférieure et 
supérieure de l’intégrale

int from{<?>} to{<?>} <?> ∫
A

B

dC

Intégrale double iint <?> ∬dAdB

Borne inférieure de 
l’intégrale double

iint from{<?>} <?> ∬
A

dBdC

Borne supérieure de 
l’intégrale double

iint to{<?>} <?> ∬
A

dBdC

Bornes inférieure et 
supérieure de l’intégrale 
double

iint from{<?>} to{<?>} <?> ∬
A

B

dCdD

Intégrale triple iiint <?> ∭dAdBdC

Borne inférieure de 
l’intégrale triple

iiint from{<?>} <?> ∭
A

dBdCdD

Borne supérieure de 
l’intégrale triple

iiint to{<?>} <?> ∭
A

dBdCdD

Bornes inférieure et 
supérieure de l’intégrale 
triple

iiint from{<?>} to{<?>} 
<?> ∭

A

B

dCdDdE

Intégrale curviligne lint <?> ∮dA

Borne inférieure de 
l'intégrale curviligne

lint from{<?>} <?> ∮
A

dB

Borne supérieure de 
l'intégrale curviligne

lint to{<?>} <?> ∮
A

dB

Bornes inférieure et 
supérieure de l'intégrale 
curviligne

lint from{<?>} to{<?>} <?> ∮
A

B

dC

Intégrale double curviligne llint <?> ∯dS
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Borne inférieure de 
l'intégrale double curviligne

llint from{<?>} <?> ∯
A

dS

Borne supérieure de 
l'intégrale double curviligne

llint to{<?>} <?> ∯
A

dS

Bornes inférieure et 
supérieure de l'intégrale 
double curviligne

llint from{<?>} to{<?>} 
<?> ∯

A

B

dS

Intégrale triple curviligne lllint <?> ∰dV

Borne inférieure de 
l'intégrale triple curviligne

lllint from{<?>} <?> ∰
A

dV

Borne supérieure de 
l'intégrale triple curviligne

lllint to{<?>} <?> ∰
A

dV

Bornes inférieure et 
supérieure de l'intégrale 
triple curviligne

lllint from{<?>} to{<?>} 
<?> ∰

A

B

dV

Remarque

Pour les opérateurs personnalisés, tapez oper dans la fenêtre de commandes, suivi de
votre opérateur personnalisé. Par exemple, en tapant  oper OP from 0 to 1 A,

vous obtiendrez la formule OP
0

1

A.

Attributs

Pour accéder aux symboles utilisés pour saisir le langage de balisage des attributs dans l’éditeur de
formules, choisissez Attributs dans la liste déroulante  en haut du panneau Éléments. 

Opération Langage de balisage Exemple de formule

Accent aigu acute <?> Á

Accent grave grave <?> À

Brève breve <?> Ă

Cercle circle <?> Å

Point dot <?> Ȧ

72 | Guide LibreOffice Math Version 7.0



Opération Langage de balisage Exemple de formule

Point double ddot <?> Ä

Point triple dddot <?> A⃛

Ligne au-dessus bar <?> Ā

Flèche vecteur vec <?> A⃗

Flèche harpon harpoon <?> A⃑

Tilde tilde <?> ~
A

Accent circonflexe hat <?> Â

Circonflexe inversé check <?> Ǎ

Longue flèche vecteur widevec {<?>} A⃗B

Longue flèche harpon wideharpoon <?> A⃑B

Long tilde widetilde {<?>} ~
AB

Long circonflexe widehat {<?>} ÂB

Longue ligne au-dessus overline {<?>} AB

Longue ligne en dessous underline {<?>} AB

Longue ligne au travers overstrike {<?>} AB

Transparent (paramètre fictif
vide pour créer de l’espace)

phantom {<?>} A B

Police gras bold <?> AB

Police normale nbold <?> AB

Police italique ital <?> or italic <?> AB

Police non italique nitalic <?> AB

Modifier la taille size <?> {<?>} AB

Modifier la police font <?> {<?>} AB

Couleur noir color black {<?>} AB
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Couleur bleu color blue {<?>} AB

Couleur vert color green {<?>} AB

Couleur rouge color red {<?>} AB

Couleur cyan color cyan {<?>} AB

Couleur magenta color magenta {<?>} AB

Couleur jaune color yellow {<?>} AB

Couleur gris color gray {<?>} AB

Couleur vert citron color lime {<?>} AB

Couleur marron color maroon {<?>} AB

Couleur bleu marine color navy {<?>} AB

Couleur vert olive color olive {<?>} AB

Couleur violet color purple {<?>} AB

Couleur argent color silver {<?>} AB

Couleur bleu canard color teal {<?>} AB

Couleur blanc (invisible sur 
fond blanc)

color white {<?>} AB

Couleurs RVB color rgb R G B {<?>} AB

Remarque

La balise font permet de modifier la police avec deux arguments : le premier est le nom
de la police et le second est le texte ou les valeurs de votre formule. Trois polices sont
disponibles  par  défaut :  Serif,  Sans et  Fixed.  Si  vous  avez  ajouté  des  polices
personnalisées au module Math (voir Chapitre 1 Création et édition de formules), vous
pouvez remplacer le premier paramètre fictif par le nom de cette police personnalisée.

Parenthèses

Pour  accéder  aux  symboles  utilisés  pour  saisir  le  langage  de  balisage  des  parenthèses dans
l’éditeur  de  formules,  choisissez  Parenthèses dans  la  liste  déroulante   en  haut du  panneau
Éléments.
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Parenthèses de 
regroupement (invisibles 
dans l’équation)

{<?>} AB

Parenthèses rondes (<?>) (AB)

Parenthèse ouvrante 
uniquement

\(<?> ( A

Parenthèse fermante 
uniquement

<?>\) A)

Crochets [<?>] [ AB]

Crochet gauche uniquement \[<?> [ A

Crochet droit uniquement <?>\] A ]

Doubles crochets ldbracket <?> rdbracket ⟦AB⟧

double crochet gauche 
uniquement

\ldbracket <?> ⟦ A

double crochet droit 
uniquement

<?> \rdbracket A⟧

Accolades lbrace <?> rbrace {AB}

Accolade gauche 
uniquement

\lbrace <?> ou \} <?> {A

Accolade droite uniquement <?> \rbrace ou <?> \} A}

Parenthèses d’angle langle <?> rangle ⟨ AB⟩

Parenthèse d’angle ouvrante
uniquement

\langle <?> ⟨ A

Parenthèse d’angle fermante
uniquement

<?> \rangle A⟩

Parenthèses d’opérateurs
langle <?> mline <?> 
rangle ⟨ AB|CD ⟩

Plafond (semi crochets 
hauts)

lceil <?> rceil ⌈ AB⌉

Plafond à gauche 
uniquement

\lceil <?> ⌈ A

Plafond à droite uniquement <?> \rceil A ⌉
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Plancher (semi crochets 
bas)

lfloor <?> rfloor ⌊ AB⌋

Plancher à gauche 
uniquement

\lfloor <?> ⌊ A

Plancher à droite 
uniquement

<?> \rfloor A ⌋

Barres simples lline <?> rline |AB|

Barre simple à gauche 
uniquement

\lline <?> |A

Barre simple à droite 
uniquement

<?> \rline A|

Barres doubles ldline <?> rdline ‖AB‖

Double barre gauche 
uniquement

\ldline <?> ‖A

Double barre droite 
uniquement

<?> \rdline A‖

Parenthèses ajustables left ( <?> right ) ( AB )

Parenthèse ouvrante 
ajustable uniquement

left ( <?> right none (AB
Parenthèse ajustable 
fermante uniquement

left none <?> right )
A
B )

Crochets ajustables left [ <?> right ] [AB ]
Crochet gauche ajustable 
uniquement

left [ <?> right none [AB
Crochet droit ajustable 
uniquement

left none <?> right ]
A
B ]

Crochets doubles ajustables
left ldbracket <?> right 
rdbracket ⟦ AB ⟧
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double crochet gauche 
ajustable uniquement

left ldbracket <?> right 
none ⟦AB

double crochet droit 
ajustable uniquement

left none <?> right 
rdbracket

A
B ⟧

Accolades ajustables
left lbrace <?> right 
rbrace {AB }

Accolade gauche ajustable 
uniquement

left lbrace {<?>} right 
none {AB

Accolade droite ajustable 
uniquement

left none {<?>} right 
rbrace

A
B }

Parenthèses d’angle 
ajustables

left langle <?> right 
rangle ⟨ AB ⟩

Parenthèse d’angle ouvrante
ajustable uniquement

left langle {<?>} right 
none ⟨ AB

Parenthèse d’angle fermante
ajustable uniquement

left none {<?>} right 
rangle

A
B ⟩

Parenthèses opérateurs 
ajustables

left langle <?> mline <?> 
right rangle ⟨ AB|

C
D ⟩

Parenthèse opérateur 
gauche ajustable

left langle <?> mline <?> 
right none ⟨ AB|

C
D

Parenthèse opérateur droite 
ajustable

left none <?> mline <?> 
right rangle

A
B|
C
D ⟩

Plafond ajustable (semi-
crochets hauts)

left lceil <?> right rceil ⌈ A
B
⌉

Plafond gauche ajustable left lceil <?> right none ⌈ AB

Plafond ajustable droit left none <?> right rceil
A
B ⌉
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Plancher ajustable (semi-
crochets bas)

left lfloor <?> right 
rfloor ⌊ AB ⌋

Plancher gauche ajustable left lfloor <?> right none ⌊ AB

Plancher droit ajustable left none <?> right rfloor
A
B ⌋

Barres simples ajustables left lline <?> right rline |AB|
Barre simple gauche 
ajustable

left lline <?> right none |AB

Barre simple droite ajustable left none <?> right rline
A
B|

Doubles barres ajustables
left ldline <?> right 
rdline ‖AB‖

Double barre gauche 
ajustable

left ldline <?> right none ‖AB

Double barre droite ajustable left none <?> right rdline
A
B‖

Accolade supérieure 
ajustable

{<?>} overbrace {<?>}
ABC⏞

D

Accolade inférieure ajustable {<?>} underbrace {<?>} ABC⏟
D

Formats

Pour accéder aux symboles utilisés pour saisir le langage de balisage des formats dans l’éditeur de
formules, choisissez Formats dans la liste déroulante  en haut du panneau Éléments.

Opération Langage de balisage Exemple de formule

Puissance (exposant droit)
<?>^{<?>} ou <?>sup{<?>} ou
<?>rsup{<?>} 2010

Indice à droite
<?>_{<?>} ou <?>sub{<?>} ou
<?>rsub{<?>} 2010
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Exposant à gauche <?>lsup{<?>} 2010

Indice à gauche <?>lsub{<?>} 2010

Exposant au centre <?>csup{<?>} 20
10

Indice au centre <?>csub{<?>} 20
10

Retour à la ligne newline 123
CD

Petit espace ` 123 456

Vide ou grand espace ~ 123 456

Pas d’espace (supprime 
l’espace entre les 
caractères)

nospace {<?>} ABC ABC

Aligner à gauche alignl <?> ABCD

Aligner au centre alignc <?> ABCD

aligner à droite alignr <?> ABCD

Pile verticale (2 éléments) binom{<?>}{<?>} AB
12

Pile verticale (plus de 2 
éléments)

stack{<?> # <?> # <?>}
AB
12
CD

Matrice
matrix{<?> # <?> ## <?> # 
<?>}

AB 12
34 CD

Remarque

Par défaut,  les caractères d’une formule sont alignés au centre. Lorsqu’une formule
s’étend sur plus d’une ligne, vous devez saisir les commandes alignl et alignr pour
aligner les éléments de votre formule à gauche ou à droite. Vous pouvez également
combiner  les  commandes  d’alignement  et  les  commandes de piles  verticales,  pour
aligner des formules à lignes multiples sur une formule précise, comme le signe égal
(=). Voir Alignement des formules avec le signe égal page 27.
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Autres

Pour accéder aux symboles utilisés pour saisir le langage de balisage d’autres commandes dans
l’éditeur de formules, choisissez Autres dans la liste déroulante  en haut du panneau Éléments. 

Opération Langage de balisage Exemple de formule

Paramètre fictif <?> ❑

Infini infinity ou infty ∞

Dérivée partielle ou marge 
d’ensemble

partial ∂

Opérateur vecteur nabla nabla ∇

Quantificateur existentiel (Il 
en existe au moins un)

exists ∃

Quantificateur existentiel (Il 
n’en existe pas)

notexists ∄

Quantificateur universel 
(pour tous)

forall ∀

H-barre (constante de 
Planck réduite)

hbar ℏ

Lambda barré lambdabar ƛ

Partie réelle d’un complexe re ℜ

Partie imaginaire d’un 
complexe

im ℑ

Fonction p (elliptique) de 
Weierstrass

wp ℘

Transformation de Laplace laplace ℒ

Flèche gauche leftarrow ←

Flèche droite rightarrow →

Flèche vers le haut uparrow ↑

Flèche vers le bas downarrow ↓

Ellipse (points en bas) dotslow …

Points au milieu dotsaxis ⋯

Points verticaux dotsvert ⋮
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Points en diagonale vers le 
haut

dotsup ou dotsdiag ⋰

Points en diagonale vers le 
bas

dotsdown ⋱

Epsilon inversé backepsilon ∍

Caractères grecs

En  général,  les  caractères  grecs  sont  disponibles  dans  la  fenêtre  Symboles (voir  Chapitre  1
Création et édition de formules page 16 pour plus de détails). Toutefois, si vous connaissez le nom
du caractère grec que vous souhaitez insérer dans votre formule, vous pouvez saisir le symbole du
pourcentage (%) dans l’éditeur de formules, suivi du nom du caractère en question.

Pour obtenir des caractères grecs en majuscules, il suffit d’activer la touche majuscule avant de
saisir le caractère désiré, par exemple %BÊTA Β (voir Tableau 3 pour consulter la liste complète de
caractères grecs en majuscules). Pour les minuscules, il suffit de saisir le caractère en minuscules,
par  exemple  %bêta β (voir  Tableau  4 pour  consulter  la  liste complète de caractères grecs en
minuscules)

Pour obtenir un caractère grec en italique, vous devez ajouter i, après le symbole du pourcentage
(%) et avant le nom du caractère grec, comme dans %iPI, Π pour les majuscules et %ipi pour les
minuscules  π. Veuillez consulter le Tableau  5 pour obtenir la liste complète des caractères grecs
italiques en majuscules et le Tableau 6 pour les caractères grecs italiques en minuscules.

Remarque

Dans  les  versions  localisées  de  LibreOffice,  les  noms  des  caractères  grecs  sont
également  localisés.  Si  un  document  n’a  pas  été  localisé  dans  la  langue
correspondante,  alors  les  noms  des  caractères  grecs  indiqués  dans  les  tableaux
suivants  pourraient  être  incorrects.  Si  tel  est  le  cas,  vous  pouvez  sélectionner  le
caractère  recherché  directement  dans  la  fenêtre  Symboles. Une  fois  le  caractère
sélectionné, le nom déjà localisé s’affiche en bas de la fenêtre.  Veuillez consulter le
Chapitre 1 Création et édition de formules pour plus de détails sur les caractères grecs
et la fenêtre Symboles.

Tableau 3 : caractères grecs en majuscules
%ALPHA Α %BÊTA Β %GAMMA Γ %DELTA Δ

%EPSILON Ε %ZÊTA Ζ %ÊTA Η %THÊTA Θ

%IOTA Ι %KAPPA Κ %LAMBDA Λ %MU Μ

%NU Ν %XI Ξ %OMICRON Ο %PI Π

%RHÔ Ρ %SIGMA Σ %TAU Τ %UPSILON Υ

%PHI Φ %KHI Χ %PSI Ψ %OMÉGA Ω

Tableau 4 : caractères grecs en minuscules
%alpha α %bêta β %gamma γ %delta δ
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%varepsilon ε %zêta ζ %êta η %thêta θ

%iota ι %kappa κ %lambda λ %mu μ

%nu ν %xi ξ %omicron ο %pi π

%rho ρ %varsigma ς %sigma σ %tau τ

%upsilon υ %varphi φ %khi χ %psi ψ

%oméga ω %varthêta ϑ %phi ϕ %varpi ϖ

%varrhô ϱ %epsilon ϵ

Tableau 5 : caractères grecs italiques en majuscules
%iALPHA Α %iBÊTA Β %iGAMMA Γ %iDELTA Δ

%iEPSILON Ε %iZÊTA Ζ %iÊTA Η %iTHÊTA Θ

%iIOTA Ι %iKAPPA Κ %iLAMBDA Λ %iMU Μ

%iNU Ν %iXI Ξ %iOMICRON Ο %iPI Π

%iRHÔ Ρ %iSIGMA Σ %iTAU Τ %iUPSILON Υ

%iPHI Φ %iKHI Χ %iPSI Ψ %iOMÉGA Ω

Tableau 6 : caractères grecs italiques en minuscules
%ialpha α %ibêta β %igamma γ %idelta δ

%ivarepsilon ε %izêta ζ %iêta η %ithêta θ

%iiota ι %ikappa κ %ilambda λ %imu μ

%inu ν %ixi ξ %iomicron ο %ipi π

%irhô ρ %ivarsigma ς %isigma σ %itau τ

%iupsilon υ %ivarphi φ %ikhi χ %ipsi ψ

%ioméga ω %ivarthêta ϑ %iphi ϕ %ivarpi ϖ

%ivarrhô ϱ %iepsilon ϵ

Caractères spéciaux

Vous pouvez insérer  des  caractères  spéciaux dans votre  formule  en les  sélectionnant  dans la
fenêtre  Symboles (voir  Chapitre  1  Création  et  édition  de  formules pour  plus  d’informations).
Toutefois, si vous connaissez le nom du caractère spécial que vous souhaitez utiliser, il vous suffit
de saisir  le symbole du pourcentage (%) dans l’éditeur de formules, suivi du nom du caractère
spécial que vous souhaitez utiliser. Le tableau 7 répertorie tous les caractères spéciaux disponibles
dans LibreOffice.
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Remarque

Dans les versions localisées de LibreOffice, les noms des caractères spéciaux sont
également  localisés.  Si  un  document  n’a  pas  été  localisé  dans  la  langue
correspondante,  alors  les  noms  des  caractères  spéciaux  indiqués  dans  le  tableau
suivant  pourraient  être  incorrects.  Si  tel  est  le  cas,  vous  pouvez  sélectionner  le
caractère  recherché  directement  dans  la  fenêtre  Symboles. Une  fois  le  caractère
sélectionné, le nom déjà localisé s’affiche en bas de la fenêtre et dans la bonne langue.
Veuillez consulter le Chapitre 1 Création et édition de formules pour plus de détails sur
les caractères spéciaux et la fenêtre Symboles.

Tableau 7 : caractères spéciaux
%pourmille ‰ %tend → %élément ∈

%pasélément ∉ %infini ∞ %angle ∢

%et ∧ %ou ∨ %différent ≠

%identique ≡ %trèsinférieurà ≪ %trèssupérieurà ≫

Mots réservés

Un mot  réservé est  une expression LibreOffice utilisée comme commande dans le  langage de
balisage du module Math, ne pouvant être utilisée comme nom de variable, ou saisie comme texte
dans une formule. Pour utiliser un mot réservé en tant que texte dans une formule, vous devez
utiliser les apostrophes.

Si vous souhaitez par exemple écrire le mot « olive » dans une formule sans toutefois attribuer la
couleur olive aux éléments de la formule. Si vous saisissez uniquement A olive B dans l’éditeur
de formules ; la formule générée est  A¿B incorrecte et un point d’interrogation culbuté s’affiche
pour vous signaler l’erreur. Pour corriger l’erreur, vous devez saisir A "olive" B dans l’éditeur de
formules AoliveB.

Pour écrire le mot « olive » en italique, comme vous le faites en général pour les variables, vous
devez  saisir  A ital{ "olive" } B dans  l’éditeur  de  formules.  La  formule  obtenue  est
AoliveB.

Les tableaux ci-dessus contiennent les listes des mots réservés du module Math, utilisés comme
commandes dans le langage de balisage.
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